
CATIA V5R16 for Designers Introduction

CATIA V5R16
• Welcome to CATIA (Computer Aided Three Dimensional Interactive Application).

• As a new user of this software package, you will be joining hands with thousands of
users of this high-end CAD/CAM/CAE tool worldwide. 

• If you are already familiar with the previous releases, you can upgrade your designing  
skills with the tremendous improvement in this latest release.

• CATIA V5, developed by Dassault Systemes, France, is a completely re-engineered,
next-generation family of CAD/CAM/CAE software solutions for Product Lifecycle  
Management.

• Through its exceptionally easy-to-use state of the art user interface, CATIA V5 delivers
innovative technologies, for maximum productivity and creativity from the concept to the  
final product. 

• CATIA V5 reduces the learning curve for the user, as it allows the flexibility of using  |
feature based and parametric designs.
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• CATIA V5 serves the basic design tasks by providing different workbenches. 

• A workbench is defined as a specified environment consisting of a set of tools, which  
allow the user to perform the specific design tasks in a particular area. 

• The basic workbenches available in CATIA V5 are :

• Part Design Workbench
The Part Design workbench is a parametric and feature-based environment, in which you 
can create solid models.

• Wireframe and Surface Design Workbench
• The Wireframe and Surface Design workbench is also a parametric and feature-based

environment, in which you can create wireframe or surface models. 

• The tools  in this workbench are similar to those in the Part Design workbench, with the  
only difference that the tools in this environment are used to create basic and advanced  
surfaces.
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• Drafting Workbench

• Assembly Design Workbench
• The Assembly Design workbench is used to assemble the components using the

assembly constraints available in this workbench.

• There are two types of assembly design approaches:

• The Drafting workbench is used for the documentation of the parts or the assemblies  
created earlier in the form of drawing views and their detailing. 

• There are two types of drafting techniques:

• Bottom-up

• Top-down

• Generative drafting

• Interactive drafting
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SYSTEM REQUIREMENTS
The following are the system requirements to ensure smooth running of CATIA V5R16 on 
your system:

• System unit: An Intel Pentium III or Pentium 4 based workstation running Microsoft 2000 
Professional Edition or Windows XP Professional Edition.

• Memory: 256 MB of RAM is the minimum recommended for all applications. 512 MB of
RAM is recommended for DMU applications.

• Disk drive: 4 GB Disk Drive space (Minimum recommended size)

• Internal/External drives: A CD-ROM drive is required for program installation.

• Display: A graphic color display compatible with the selected platform-specific graphic
adapter. The minimum recommended monitor size is 17 inches.

• Graphics adapter: A graphics adapter with a 3D OpenGL accelerator is required with
minimum resolution of 1024x768 for Microsoft Windows workstations and 1280x1024 for
UNIX workstations.
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GETTING STARTED WITH CATIA V5R16
• Install CATIA V5R16 on your system and then start it by double-clicking on the shortcut

icon of CATIA V5R16 on the desktop of your computer. 

• You can also choose Start > Programs > CATIA > CATIA V5R16 from the taskbar menu,
as shown in the figure.

Starting CATIA V5R16 using the taskbar shortcuts
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The initial screen that appears after starting CATIA V5R16
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The screen that appears after closing the initial product file
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IMPORTANT TERMS AND DEFINITIONS
• Feature-based Modeling

• A feature is defined as the smallest building block that can be modified individually. 

• A model created in CATIA V5 is a combination of a number of individual features and
each feature is related to the other directly or indirectly.

• Parametric Modeling
The parametric nature of a software package is defined as its ability to use the standard
properties or parameters in defining the shape and size of a geometry.

Body of a pipe housing Modified body of pipe housing
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• Bidirectional Associativity
The bidirectional associativity ensures that if any modification is made in the model in any 
one of the workbenches of CATIA V5, it is automatically reflected in the other workbenches 
immediately.

The drawing views of the body part 
before making the modifications

The drawing views, after modifications
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• CATPart
CATPart is a file extension associated with all the files that are created in Sketcher, Part
Design, and Wireframe and Surface Design workbenches of CATIA V5.

• CATProduct
CATProduct is a file extension associated with all the files that are created in Assembly
Design workbench of CATIA V5.

• CATDrawing
CATDrawing is a file extension associated with all the files that are created in Drafting
workbench of CATIA V5.
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• Specification Tree
• The specification tree keeps a track of all the operations

that are carried on the part, as shown in the figure. 

• The specification tree that appears when you start a new  
file under the Part Design workbench, is as shown in the
figure.

The specification tree that 
appears on starting a new 
CATPart file

• Compass
• It is a tool that is used to manipulate the orientation of parts,

assemblies, or sketches. 

• You can also orient the view of the parts and assemblies.  

• By default, it appears on the top right corner of the geometry 
area.

The Compass
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• Constraints
• Constraints are logical operations that are performed on the selected element to define its

size and location with respect to other elements or reference geometries. 

• The constraints in Sketcher workbench are called geometric constraints and the constraints 
available in the Assembly Design workbench are called assembly constraints. 

• Geometric Constraints
These are the logical operations performed on sketched elements to define their size and 
position with respect to other elements.
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The constraints available in the Sketcher workbench are:

• Distance

• Length

• Angle

• Radius / Diameter

• Semimajor axis

• Semiminor axis

• Symmetry

• Midpoint

• Equidistant point

• Fix

• Coincident

• Concentricity

• Tangency

• Parallelism

• Perpendicular

• Horizontal

• Vertical
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• Assembly Constraints
Constraints available in the Assembly Design workbench are logical operations performed 
to restrict the degree of freedom of the component and to precisely define their location and 
position with respect to other components of the assembly.

• Coincidence Constraint

• Contact Constraint

• Offset Constraint

• Angle Constraint

• Fix Component

• Fix Together

• Quick Constraint

• PartBody
• It is the default body available under Part Design workbench.

• All the solid related features, such as pad, pocket, shaft, and so on are placed inside it.
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• Geometrical Set
The geometrical set is defined as a body that includes newly created planes, surfaces, 
wireframe elements, and reference elements.

• Wireframe
The wireframe construction elements aid in creating surfaces and are used as a substitute 
to entities drawn in the Sketcher workbench.

• Surface
• Surface are geometric feature which have no thickness. 

• They are generally used to create complex shapes that are difficult to create using the
solid feature.

• Feature
• A features is defined as a basic building block of a solid model. 

• The combination of various features results in a complete model.
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• Reframe on
Sometimes a feature, body, or a sketch may not be visible in the available space in the 
geometry area, this operation is used to view that particular selection in the available 
display space.

• Center Graph
This option brings the selected feature, body, or sketch in the specification tree to the 
middle left portion of the geometry area.
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UNDERSTANDING THE FUNCTIONS OF THE MOUSE
BUTTONS
• To work with CATIA V5 design workbenches, it is necessary that you understand the

functions of the mouse buttons. 

• The efficient usage of these three buttons, along with the CTRL key on the keyboard, can  
reduce the time involved in completing the design task.

Using the three button mouse 
to perform the zoom in and 
zoom out operations

Using the three button mouse to 
perform the rotate operation
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TOOLBARS
• CATIA V5 offers a user-friendly design environment by providing specific toolbars to each  

workbench.

• The toolbars that appear in various workbenches are:

• Standard Toolbar

The Standard toolbar

• This toolbar is common to all workbenches of CATIA V5.

• The following figure shows the Standard toolbar.
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• Status Bar

The status Bar

The Status bar, which appears at the bottom of the CATIA V5 window, comprises of three 
areas, as shown in the figure.

• Current Information or Dialog Box
The Current Information or Dialog Box area displays the current information about the 
selected feature or current tool.

• Power Input Field Bar
The Power Input Field bar lets you invoke the commands and enter the data or value that 
can be directly associated with the feature.
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• User Information Package Button

• Part Design Workbench Toolbars

Choosing this button will open a window with a default link that is C:\Program Files\Dassault 
Systemes\B16\intel_a\resources\galaxy\default.htm.

You can invoke the Part Design workbench by choosing the New button from the Standard
toolbar and selecting Part from the New dialog box.

• Dialog Box Display Button
Choosing the Dialog Box Display button will turn on and turn off the display of the current 
dialog box.
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• View Toolbar

• Select Toolbar

The Select toolbar

• Sketcher Toolbar

The Sketcher toolbar

The View toolbar
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• Profile Toolbar

The Profile toolbar
• Constraint Toolbar

The Constraint toolbar
• Operation Toolbar

The Operation toolbar
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• Sketch tools Toolbar

The Sketch tools toolbar
• Sketch-Based Features Toolbar

The Sketch-Based Features toolbar
• Dress-Up Features Toolbar

The Dress-Up Features toolbar
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• Measure Toolbar

The Measure toolbar
• Transformation Features Toolbar

The Transformation Features toolbar
• Surface-Based Features Toolbar

The Surface-Based Features toolbar
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• Apply Material Toolbar

The Apply Material
toolbar

• Wireframe and Surface Design Workbench Toolbars

• Surfaces Toolbar

The Surfaces toolbar

You can invoke the Wireframe and Surface Design workbench from the main menu bar 
by choosing Start > Mechanical Design > Wireframe and Surface Design.
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• Operations Toolbar

The Operations toolbar

• Wireframe Toolbar

The Wireframe toolbar
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• Assembly Design Workbench Toolbars

• Product Structure Tools Toolbar

The Product Structure Tools toolbar

• Constraints Toolbar

The Constraints toolbar

You can invoke the Assembly Design workbench by choosing the New button from the
Standard toolbar and selecting Product from the New dialog box.
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• Move Toolbar

The Move toolbar

• Space Analysis Toolbar

The Space Analysis toolbar



CATIA V5R16 for Designers Introduction

• Drafting Workbench Toolbars

• Drawing Toolbar

The Drawing toolbar

• Views Toolbar

The Views toolbar

To invoke the Drafting workbench, choose the New button from the Standard toolbar 
and select Drawing from the New dialog box.
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• Generation Toolbar

The Generation toolbar The flyout that appears when 
a down arrow is chosen

HOT KEYS
• CATIA V5 is more popularly known for its icon driven

structure.

• The hot keys, along with their functions, are listed in the
table shown.
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COLOR SCHEME
CATIA allows you to use various color schemes as the background screen color, and also 
for displaying the entities on the screen.

The Properties dialog box
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Learning Objectives:
• Understand the Sketcher workbench of CATIA V5.

• Start a new file in the Part workbench and invoke the Sketcher .
workbench within it.

• Set up the Sketcher workbench.

• Understand some important Sketcher terms.

• Draw sketches using some of the tools in the Sketcher 
workbench.

• Use some of the drawing display tools.
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THE SKETCHER WORKBENCH
• Most of the components designed using CATIA V5 are a combination of sketched  

features, placed features, and derived features. 

• The placed features are created without drawing a sketch, whereas the sketched
features require a sketch that defines the shape of the sketched feature. 

Solid Model of a Link Base sketch for the solid model
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STARTING A NEW FILE
• When you start CATIA V5R16, a new Product file with the name Product1 is displayed

on the screen, as shown in the figure. 

Initial screen that appears after starting CATIA V5R16 The New Part dialog box

• Choose Start > Mechanical Design > Part Design to make sure that you are in the Part  
Design workbench.

• The New Part dialog box is displayed, as shown in the figure.
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• Alternatively, you can choose the File > New option from the menu bar; the New dialog
box is displayed, as shown in the figure.

The New dialog box

• A new file in the Part Design workbench is displayed on the screen, as shown in the
figure.

A new Part Design workbench file
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INVOKING THE SKETCHER WORKBENCH
• To invoke the Sketcher workbench, choose the down arrow on the right of the Sketch

button in the Sketcher toolbar; a flyout will appear.

• The Sketcher flyout as an independent toolbar, is as shown in the figure.

The Sketcher toolbar
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• Invoking the Sketcher Workbench using the Sketch Button

The Sketcher workbench invoked using the 
yz plane as the sketching plane

• To invoke the Sketcher workbench using is method, choose the Sketch button
from the Sketcher toolbar.

• The Sketcher workbench that appears after on selecting the yz plane as the
sketching plane, is shown in the figure.
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• Invoking the Sketcher Workbench using the Positioned Sketch
Button

The Sketch Positioning
dialog box

• To invoke the Sketcher workbench using this option, choose the Positioned Sketch
button from the Sketcher toolbar.

• The Sketch Positioning dialog box will be displayed, as shown in the figure.
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SETTING UP THE SKETCHER WORKBENCH
• After invoking the Sketcher workbench, you need to set the workbench as per the  

sketching or drawing requirements. 

• These requirements include modifying units, grid settings, and so on.

• Modifying Units

The Options dialog box with the 
Units tab chosen

• The Options dialog box after invoking the Units tab, is shown in the figure.
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• Modifying the Grid Settings

The Options dialog box with the 
Sketcher option selected

• To change the values of Primary Spacing and Graduations, choose Tools > Options
from the menu bar; the Options dialog box will be displayed. 

• Choose the Mechanical Design option from the tree on the left of the dialog box. 

• Next, choose the Sketcher option to display the Sketcher tab on the right of the Options
dialog box, as shown in the figure.
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UNDERSTANDING THE SKETCHER TERMS
• Specification Tree

• AbsoluteAxis
The various levels under Sketch.1 in the specification tree are:

• Origin
• Hdirection
• VDirection

• Snap to Point

The expanded form of 
the specification tree

• Construction/Standard Element
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• Select Toolbar

The Select toolbar

• Select

• Selection Trap

• Intersecting Trap

• Polygon Trap

• Paint Stroke Selection

• Outside Trap Selection

• Intersecting Outside Trap Selection

The tools available in Select toolbar are:

The Select toolbar
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• Inferencing Lines

An example of an inferencing line

• The inferencing lines are temporary lines that are used to track a particular point on the
screen.

DRAWING SKETCHES USING THE SKETCHER TOOLS
• Drawing Lines

CATIA being parametric in nature, allows the user to draw a line of any length  
and at any angle, and then change it to the desired length and angle.
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• Drawing Lines by Specifying Points in the Geometry Area

A line drawn by selecting the start and 
endpoints from the geometry area

• Drawing Lines Using the Sketch tools Toolbar

The expanded form of the Sketch tools toolbar after invoking the Line tool

• Drawing Lines by entering the Start and End point values
• Drawing Lines with a Symmetrical Extension
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The Line toolbar

• Drawing Infinite Lines
To draw an infinite line, invoke the Infinite Line tool from the Line toolbar.

• Drawing Bi-Tangent Lines
Bi-Tangent lines are the lines that are tangent to two circles, arcs, ellipses, conics,
or any curved geometry.

• Drawing Bisecting Lines
Bisecting lines are the lines that pass through two intersecting lines such that the angle 
formed between them is divided equally.
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• Drawing Lines Normal To Curve

• Drawing Center Lines

An axis drawn in the 
geometry area

• You can draw a center line in CATIA using the Axis tool.

• Generally, this tool is used to create the axis for the revolved feature.

To draw a line normal to a curve, choose the Line Normal To Curve button from the
Line toolbar.



CATIA V5R16 for Designers Chapter 1

• Drawing Rectangles, Oriented Rectangles, and Parallelograms

• Drawing Rectangles

• Drawing Oriented Rectangles
The Predefined Profile toolbar

Selecting the corner points to 
draw an oriented rectangle

Rectangle is a basic geometry that comprises of four sides.
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• Drawing Parallelograms

• Drawing Points

A parallelogram drawn by specifying 
the corner points

The Point toolbar

A point is defined as the geometrical element that has no magnitude, length, width, or  
thickness.
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• Drawing Circles

The Circle toolbar

• To draw a circle, choose the down arrow on the right of the Circle button in the
Profile toolbar.

• The Circle toolbar is displayed, as shown in the figure.

• Drawing Points by Clicking

To draw points by clicking, invoke the Point by Clicking tool from the Point toolbar;  
the Sketch tools toolbar expands and you will be prompted to click to create the point.
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• Drawing Circles Using the Circle Tool
To draw a circle, invoke the Circle tool from the Circle toolbar.

• Drawing a Three Point Circle
To draw a three point circle, invoke the Three Point Circle tool from the Circle toolbar;  
the Sketch tools toolbar expands.

• Drawing Circles using Coordinates
• Invoke the Circle Using Coordinates tool from the Circle toolbar; the Circle

Definition dialog box will be displayed. 

• You can specify the coordinate values of the center point and radius, using the
options in this dialog box.

• Drawing Tri-Tangent Circles
To draw a tri-tangent circle, invoke the Tri-Tangent Circle tool from the Circle toolbar.
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• Drawing Arcs

• Drawing Arcs by Defining the Center Point

• Drawing Three Point Arcs
An arc

Selecting the points to 
draw a three point arc

• An arc is a geometric element that forms a sector of a circle or ellipse.
• The tools to draw arcs are available in the Circle toolbar.
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• Drawing Three Point Arcs Starting With Limits

Selecting the points to 
draw a three point arc 
starting with limits

To draw a three point arc starting with limits type of arc, invoke the Three Point Arc
With Limits tool from the Circle toolbar.

• Drawing Profiles
In CATIA, a profile is defined as a combination of continuous lines and arcs.

An open profile drawn 
using the Profile tool

The Sketch tools toolbar
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• Drawing a Tangent Arc Using the Profile Tool
To draw a tangent arc in continuation with the line, invoke the Profile tool from the Profile
toolbar.

A tangent arc being drawn using 
the Profile tool

• Drawing Three Point Arcs using the Profile Tool
• To draw a three point arc using the Profile tool, invoke it from the Profile toolbar.

• You will notice the Three Point Arc button is available in the Sketch tools toolbar.
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DRAWING DISPLAY TOOLS
The drawing display tools for viewing drawing elements or geometries are available in the  
View toolbar, as shown in the figure.

The View toolbar

• Fit All In
The Fit All In tool is used to increase the geometry area so that all the sketched 
elements or geometry are included in the visible space.

• Pan
The Pan tool is used to drag the current view in the geometry area.
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• Zoom In
The Zoom In tool is used to zoom into the sketches in increments.

• Zoom Out
The Zoom Out tool is used to zoom out of the sketch in increments.

• Zoom Area
The Zoom Area tool is used to define an area, which is to be magnified and viewed in the 
available geometry area.

• Normal View
The Normal View tool is used to orient the view normal to the sketch plane in the  
current Sketcher workbench.

• Splitting the Drawing Area into Multiple Viewports
The Create Multi-View tool is used to split the drawing area into four viewports.
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• Hiding and Showing Geometric Elements
To hide a sketcher element, invoke the Hide/Show tool by choosing the Hide/Show
button from the View toolbar; you are prompted to select an element.

• Swap Visible Space
To view the space where all hidden elements are stored, invoke the Swap visible 
space tool from the View toolbar.
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Tutorial 1
In this tutorial, you will draw the sketch of the model shown in Figure A. The sketch 
is shown in Figure B. You will not dimension the sketch. The solid model and the 
dimensions are given only for your reference.     (Expected time: 30 min)

Figure A The solid model for Tutorial 1 Figure B The sketch of the model
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1. Start CATIA V5 and then start a new CAT part file.

2. Draw the sketch of the model using the Line, Arc, and Circle tools, as shown in 
Figure C and Figure D.

Figure C The outer loop of the sketch Figure D The final sketch for 
Tutorial 1

3. Save the file in \My Documents\CATIA\c01 folder and then close it.
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Tutorial 2
In this tutorial, you will draw the sketch of the model shown in Figure A. The sketch 
is shown in Figure B. You will not dimension the sketch. The solid model and the 
dimensions are given only for your reference.     (Expected time: 30 min)

Figure A The solid model 
for Tutorial 2

Figure B The sketch of the model
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1. Start a new CATpart file.

2. Draw the sketch of the model using the Profile and Rectangle tool, as shown in Figure C,
Figure D and Figure E.

Figure C The sketch after drawing 
the three lines and a tangent arc

Figure D The sketch after drawing 
outer loop of the sketch
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Figure E The final sketch after drawing 
the inner loop of the sketch

3. Save the file in \My Documents\CATIA\c01 folder and then close it.
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Tutorial 3
In this tutorial, you will draw the sketch of the model, as shown in Figure A. The sketch is 
shown in Figure B. You will not dimension the sketch. The solid model and dimensions 
are given for your reference.     (Expected time: 30 min)

Figure A The solid model 
for Tutorial 3

Figure B The sketch for the solid 
model
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1. Start a new CATpart file.
2. Draw the sketch of the model using the Rectangle, Profile, and Circle tools, as shown in 

Figure C, Figure D and Figure E.

Figure C The outer loop of the 
sketch

Figure D The sketch after drawing 
the elongated hole
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Figure E The final sketch

3. Save the file in \My Documents\CATIA\c01 folder and then close it.
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Tutorial 4
In this tutorial, you will draw the sketch of the model shown in Figure A. The sketch is 
shown in Figure B. Do not dimension the sketch. The solid model and the dimensions 
are given only for your reference. (Expected time: 30 min)

Figure A The solid model for 
Tutorial 4

Figure B The sketch for the 
solid model
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1. Start a new CATpart file.
2. Draw the sketch of the model using the Profile and the Circle tools, as shown in Figure C 

and Figure D.

Figure C The sketch after drawing 
the outer loop

Figure D The final sketch for Tutorial 4

3. Save the file in \My Documents\CATIA\c01 folder and then close it.
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Exercise 1
Draw the sketch of the model shown in Figure A. The sketch to be drawn is shown in 
Figure B. Do not dimension it. The solid model and the dimensions are given only for 
your reference. (Expected time: 30 min)

Figure A The solid model for 
Exercise 1

Figure B The sketch of the model
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Exercise 2
Draw the sketch of the model shown in Figure A. The sketch to be drawn is shown in 
Figure B. Do not dimension it. The solid model and the dimensions are given only for 
your reference. (Expected time: 30 min)

Figure A The solid model 
for Exercise 2

Figure B The sketch of the model
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Learning Objectives:
• Draw ellipses.

• Draw splines.

• Connect two elements using an arc or a spline.

• Draw elongated holes.

• Draw cylindrical elongated holes.

• Draw key holes.

• Draw hexagons.

• Draw centered rectangles.

• Draw centered parallelograms.

• Draw different types of conics.

• Edit and modify sketches.
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OTHER SKETCHING TOOLS
• Drawing Ellipses

To draw an ellipse, invoke the Ellipse tool by choosing the Ellipse button from the 
Conic toolbar, as shown in the figure.

The Conic toolbar

Specifying three points to draw 
an ellipse

The resulting ellipse
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• Drawing Splines
To draw a spline, choose the down arrow on the right of the Spline button in the 
Profile toolbar and invoke the Spline toolbar, as shown in the figure.

The Spline toolbar Specifying points for drawing a spline
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• Connecting two Elements by a Spline or an Arc
• Two elements such as lines, arcs, ellipses, circles, or splines can be connected  

together by an arc or spline. 

• To do so, invoke the Connect tool from the Spline toolbar; the Sketch tools
toolbar expands, as shown in the figure.

The Sketch tools toolbar after invoking 
the Connect tool

• Connecting Two Elements with a Spline
• By default, the Connects with a Spline button is chosen in the Sketch tools toolbar.

• You are prompted to select the first element to be connected.
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• Drawing Elongated Holes

An elongated hole profile

To draw an elongated hole invoke the Elongated Hole tool from the Predefined
Profile toolbar.

• Connecting Two Elements with an Arc
• To connect two selected elements with an arc, choose the Connect button from the  

Spline toolbar.

• Choose the Connects with an Arc button from the Sketch tools toolbar; you will be  
prompted to select the first element to be connected.
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• Drawing Cylindrical Elongated Holes

A cylindrical elongated hole

To draw a cylindrical elongated hole, invoke the Cylindrical Elongated Hole tool
from the Predefined Profile toolbar.

• Drawing Keyhole Profiles
To draw a keyhole profile, invoke the Keyhole Profile tool from the Predefined
Profile toolbar.

A keyhole profile
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• Drawing Hexagons

Hexagon drawn using 
the Hexagon tool

To draw a hexagon choose the Hexagon button from the  
Predefined Profile toolbar. 

Center rectangle along with 
the center point and the point 
on the corner of the rectangle

• Drawing Centered Rectangles
To draw a centered rectangle, choose the Centered
Rectangle button from the Predefined Profile
toolbar.
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• Drawing Centered Parallelograms

Centered parallelogram with the 
first line, second line, and the 
point on parallelogram

To draw a centered parallelogram, choose the Centered Parallelogram button
from the Predefined Profile toolbar.

• Drawing Conics
To draw various conics available in CATIA V5R16, choose the down arrow available on the 
right of the Ellipse button in the Profile toolbar.
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• Drawing a Parabola by Focus

• Drawing a Hyperbola by Focus

Points used to draw 
a parabola

Specifying the apex 
of the hyperbola

Specifying the start point 
of the hyperbola

To draw a parabola by focus, invoke the Parabola by Focus tool from the Conic
toolbar.

To draw a hyperbola by focus invoke the Hyperbola by Focus tool from the Conic
toolbar.
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• Drawing Conics

A Conic

To draw a conic, invoke the Conic tool from the Conic toolbar.
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EDITING AND MODIFYING SKETCHES
• CATIA V5 provides you with a number of tools that can be used to edit the sketched  

elements.

• These include trimming the sketches using the quick trim, breaking a sketched element,  
filleting the sketches, adding chamfer to the sketches, and so on.

• Trimming Unwanted Sketched Elements
• Invoke the Relimitations toolbar by choosing the down arrow provided on the right

of the Trim button in the Operation toolbar.

• The Relimitations toolbar is shown in the figure.

The Relimitations toolbar
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Elements to be selected for trimming The resulting trimmed elements

Elements to be selected for trimming The resulting trimmed elements
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• Extending Sketched Elements

Elements selected to be extended The resulting extended element

• Trimming by Using the Quick Trim Tool
CATIA V5 also provides you with a tool using which you can quickly trim the unwanted  
sketched elements.
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• Filleting Sketched Elements

Elements to be selected and 
the resulting filleted sketched 
elements

Fillets created using the selected Trim
First Element and the No Trim buttons

In the Sketcher workbench of CATIA V5, you are provided with the Corner tool to 
fillet the sketched elements.
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• Chamfering Sketched Elements

Elements to be selected and the 
resulting chamfer created

The Sketcher workbench of CATIA V5 also provides you with a Chamfer tool to 
chamfer the sketched elements.
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• Mirroring Sketched Elements
• You can mirror the sketched elements along the

mirror line in the Sketcher workbench of CATIA
V5 using the Mirror tool. 

• Choose the down arrow on the right of the Mirror
button provided in the Operation toolbar to invoke  
the Transformation toolbar, as shown in the figure. The Transformation toolbar

Elements selected to be mirrored 
and the mirror line to be selected

The Resulting mirrored sketch
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• Mirroring Elements Without Duplication

• Translating Sketched Elements

The Translation Definition
dialog box

The Symmetry tool mirrors the sketched elements about a mirror axis but deletes 
the original elements.

The Sketcher workbench provides you the Translate tool to move the selected 
sketched elements from their initial position to the required destination.
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• Rotating Sketched Elements

The Rotation Definition
dialog box

Points to be selected and 
the rotated elements

• The Rotate tool is used to rotate the sketched elements around a rotation center
point.

• Select the elements by drawing a window around them and then choose the Rotate
button from the Transformation toolbar.

• The cursor is replaced by the point cursor and the Rotation Definition dialog box
is displayed, as shown in the figure.
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• Scaling Sketched Elements

The Scale Definition
dialog box

• To scale the sketched elements, select them and then choose the Scale button from
the Transformation toolbar.

• The Scale Definition dialog box is displayed, as shown in the figure.
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• Offsetting Sketched Elements

The four additional buttons in the 
expanded Sketch tools toolbar

Elements created after offsetting

To offset the sketched elements, select them and then choose the Offset button from
the Transformation toolbar.
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• Modifying Sketched Elements

• Modifying the Sketched Line

The Line Definition dialog box

You can modify the sketched elements, using various tools available in the Sketcher
environment of CATIA V5.

• You can modify a sketched line using the Line Definition dialog box.

• To invoke it, double-click on the sketched line.

• The Line Definition dialog box is displayed, as shown in the figure.
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• Modifying a Sketched Circle

The Circle Definition
dialog box

• You can modify a sketched circle using the Circle Definition dialog box.

• You can invoke this dialog box by double-clicking on the sketched circle.

• The Circle Definition dialog box is displayed as shown in the figure.
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• Modifying the Sketched Arc

• Modifying the Sketched Spline

The Spline Definition dialog box

• The arcs are also modified using the Circle Definition dialog box.

• To invoke it, double-click on the arc to be modified. 

You can modify a spline using the Spline Definition dialog box, which is displayed when
you double-click on the spline that needs to be modified.
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• Modifying the Sketched Point

The Point Definition
dialog box

To modify a sketched point, double click on it; the Point  Definition
dialog box is displayed, as shown in the figure.

• Modifying the Sketched Ellipse

The Ellipse Definition
dialog box

To modify a sketched ellipse, double-click on it; the Ellipse
Definition dialog box is displayed, as shown in the figure.



CATIA V5R16 for Designers Chapter 2

• Modifying the Sketched Elements by Dragging

• Deleting Sketched Elements

The modification of the sketched element can be done by dragging its start point, end  
point, profile, or the control points.

• To delete the sketched element, select the sketched element and choose the DELETE key.  

• You can also delete the sketched elements by selecting them and then right-clicking to  
invoke the contextual menu.
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Tutorial 1
In this tutorial, you will draw the sketch of the model shown in Figure A. The sketch is 
shown in Figure B. You will not dimension the sketch. The solid model and the dimensions 
are given only for your reference. (Expected time: 30min)

Figure A The Model for Tutorial 1 Figure B The sketch for Tutorial 1
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1. Start a new file in the Part workbench and draw the outer loop of the sketch using the Circle
and By-Tangent Line tool, as shown in Figure C, Figure D, Figure E and Figure F .

Figure C The Sketch after 
drawing the first circle

Figure D The Sketch after drawing the second 
circle

Figure E The sketch after drawing 
the first tangent line

Figure F The sketch, after drawing 
the second tangent line
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2. Trim the unwanted portion of the outer loop of the sketch using the Quick Trim tool, as 
shown in Figure G and Figure H.

Figure G The unwanted portion 
of the sketch to be trimmed

Figure H The sketch after trimming 
the unwanted portion
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3. Draw the inner loops of the sketch using the Circle tool, as shown in Figure I.

4. Save the file in \My Documents\CATIA\c02 folder and then close it.

Figure I Final sketch
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Tutorial 2
In this tutorial, you will draw the sketch of the model shown in Figure A. The sketch 
is shown in Figure B. You will not dimension the sketch. The solid model and the 
dimensions are given only for your reference.     (Expected time: 30min)

Figure A The model 
for Tutorial 2

Figure B The Sketch of Tutorial 2
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1. Start a new file in the Part workbench.

2. Draw the outer loop of the sketch using the Rectangle tool and then edit it using the 
Corner tool, as shown in Figure C, Figure D and Figure E.

Figure C The sketch after 
drawing centered 
rectangle

Figure D The vertices 
to be selected

Figure E The final outer 
loop of the sketch
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3. Draw the inner loop of the sketch using the Circle, Elongated Hole, and Cylindrical
Elongated Hole tool, as shown in Figure F, Figure G and Figure H.

Figure F The sketch 
after drawing the 
circle

Figure G The sketch 
after drawing the 
elongated hole

4. Save the file in \My Documents\CATIA\c02 folder and then close it.

Figure H The final sketch
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Tutorial 3
In this tutorial, you will draw the sketch of the model, as shown in Figure A. The sketch 
is shown in Figure B. You will not dimension the sketch. The solid model and the 
dimensions are given only for your reference.     (Expected time: 30 min)

Figure A The model for Tutorial 3 Figure B The sketch for Tutorial 3
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1. Draw the right half of the sketch using the Profile and Elongated Hole tool, as shown in
Figure C.

2. Mirror the sketch along the vertical axis of origin, as shown in Figure D.

Figure C The sketch 
after creating the 
elongated hole

Figure D The sketch after mirroring
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Figure E The sketch after creating the 
horizontal elongated hole

4. Save the file in \My Documents\CATIA\c02 folder and then close it.

3. Draw the elongated hole in the lower portion of the sketch, as shown in Figure E.
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Exercise 1
Draw the sketch of the model shown in Figure A. The sketch to be drawn is shown 
in Figure B. Do not dimension it. The solid model and dimensions are given for 
your reference. (Expected time: 30 min)

Figure A The model 
for Exercise 1

Figure B The sketch for Exercise 1
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Exercise 2
Draw the sketch of the model shown in Figure A. The sketch to be drawn is shown 
in Figure B. Do not dimension the sketch. The solid model and dimensions are 
given only for your reference. (Expected time: 30 
min)

Figure A The model for 
Exercise 2

Figure B The sketch for Exercise 2
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Learning Objectives:
• Add geometrical constraints to sketches.

• Add dimensional constraints to sketches.

• Understand the concept of iso-constraint, under-constraint, and over-constraint
sketches.

• Analyze and delete over defining constraints.

• Create base features by extruding sketches.

• Create base features by revolving sketches.

• Dynamically rotate the model view .

• Modify the view orientation

• Switch between various display modes

• Assign material to the model
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CONSTRAINING SKETCHES
• You need to constrain the sketches so as to restrict their degrees of freedom and

make them stable. 

• The first step is to apply the geometrical constraints to the sketch, some of which are
automatically applied, while drawing. 

• After applying the remaining geometrical constraints, you need to add dimensional
constraints, using the tools in the Constraint toolbar, as shown in the figure.

Tools in the Constraint toolbar
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CONCEPT OF ISO-CONSTRAINED SKETCHES
Generally, after drawing the sketch and applying the constraints, the sketch can exist in any 
one of the following five stages:

• Iso-Constrained

• Under-Constrained

An Iso-Constraint sketch, also known as fully constraint sketch, is the one in which all  
degrees of freedom, of each element, are defined using the geometric and dimensional  
constraints.

An Under-Constrained sketch is one in which all degrees of freedom, of each entity are  
not completely defined using constraints.

• Over-Constrained
An Over-Constrained sketch is the one in which some extra constraints are applied.
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• Inconsistent

• Not Changed

The Inconsistent stage of the sketch occurs when a change is made to the sketch, but  
the its current geometry cannot accommodate that change.

The Not Changed stage of the sketch occurs when the sketched elements are over  
defined and you change the value of the dimensional constraints.
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ADDING GEOMETRICAL CONSTRAINTS
• Adding Automatic Constraints

This tool is active by default and therefore, as you draw an 
element, some constraints are automatically applied to it.

The coincident constraint 
applied automatically

• Applying Additional Constraints to the Sketch
You need to manually apply additional constraints to the 
sketch by defining them using the Constraint Definition
dialog box, as shown in the figure.

The Constraint Definition
dialog box



CATIA V5R16 for Designers Chapter 3

The constraints that are provided in the Constraint Definition dialog box are:

• Distance
• Length
• Angle
• Radius / Diameter
• Semimajor axis
• Semiminor axis
• Symmetry
• Midpoint
• Equidistant point

• Fix
• Coincident
• Concentricity
• Tangency
• Parallelism
• Perpendicular
• Horizontal
• Vertical
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The Constraint Creation
toolbar

• Applying Dimensional Constraints
• After applying the geometric constraints, you need to apply the dimensional  

constraints to fully define the sketches, using the Constraint tool.

• Choose the Constraint button from the Constraint toolbar or the Constraint
Creation toolbar shown in the figure.
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• Linear Dimensioning of a Line and Between Two Points

The contextual menu

Element selected to be 
dimensioned

Resulting linear dimension

• To apply a linear dimension between two points, invoke the  
Constraint tool, and select two points from the geometry area. 

• Next, right-click to display the contextual menu, as shown in  
the figure. 
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Elements selected to be 
dimensioned

Resulting linear dimension

• Dimensioning An Inclined Line
• By default, whenever you select an inclined line, the aligned dimension is applied to it. 

• You can also apply a horizontal or vertical dimension to it.

• Dimensioning An Arc and A Circle
• By default, the diameter dimension is applied to circles and the radius dimension is applied

to arcs.

• Invoke the Constraint tool and select the arc or the circle that you need to dimension.
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Angular dimension placed according 
to the placement point

Angular dimension placed according 
to the placement point

• Applying an Angular Dimension

Angular dimension placed according 
to the placement point

Angular dimension placed according 
to the placement point
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• Applying Linear Diameter Dimensions

Model created by revolving a 
sketch around the horizontal 
center line

Element and center line selected 
and the resulting linear diameter 
dimension

• Modifying Dimensions After Placing

The Constraint Definition dialog
box invoked after double-clicking 
the dimension

To modify the dimension value, double-click on it; 
the Constraint Definition dialog box is displayed, 
as shown in the figure.
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• Applying Contact Constraints
The Contact Constraint tool is used to automatically apply geometrical constraints
to the selected elements, depending on their position and geometry. 

• Applying Fix Together Constraints
To apply this constraint, select all the entities that you need to fix together, and choose
the Fix Together button from the Constrained Geometries toolbar; the Fix Together
Definition dialog box will be displayed, as shown in the figure.

The Fix Together Definition
dialog box

The Fix Together constraint applied 
to the sketched entities
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The Auto Constraint
dialog box

Automatic dimensions applied 
using the Chained option

Automatic dimensions applied 
using the Stacked option

• Applying Automatic Constraints
• To apply constraints, select the elements to be constrained, and choose the Auto

Constraint button in the Fix Together flyout in the Constraint toolbar; the Auto
Constraint dialog box is 

• The number of elements selected is displayed in the Elements to be constrained
display box, as shown in the figure.
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• Editing Multiple Dimensions
• To use the Edit Multi-Constraint tool, you first need to apply all the required

dimensions to the sketch. 

• Next, choose the Edit Multi-Constraint button from the Constraint toolbar; the
Edit Multi-Constraint dialog box will be displayed, as shown in the figure.

The Edit Multi-Constraint
dialog box



CATIA V5R16 for Designers Chapter 3

ANALYZING AND DELETING OVER DEFINING
CONSTRAINTS
• After applying dimensions to the sketches, if the sketch is over-constrained, you need to

delete the over defining constraints, which are displayed in purple. 

• Select the overdefining constraint and press the DELETE key. 

EXITING THE SKETCHER WORKBENCH
Choose the Exit workbench button from the Workbench toolbar; you will exit the 
Sketcher workbench and the Part Design workbench is invoked.
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Figure A The Pads toolbar

CREATING BASE FEATURES BY EXTRUDING
• To invoke the Pads toolbar, choose the down arrow on the right of the Pad button

in the Sketch-Based Features toolbar.

• The Pads toolbar is shown in Figure A.

Figure B The Pad Definition
dialog box

• Select the sketch and then choose the Pad button from the Pads toolbar; the Pad
Definition dialog box is displayed, as shown in Figure B.
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The sketch after exiting the 
Sketcher workbench

Dynamically dragging the 
Limit handle to specify the 
depth of extrusion

The model after extruding
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Thickness added using 
different options

An extruded feature created 
using the Thin option

• Creating a Thin Extruded Feature
• To create a thin extruded feature, choose the Thick check box from the Pad Definition

dialog box. 

• The dialog box expands and the options in the Thin Pad area of the Pad Definition dialog
box are invoked, as shown in the figure.

The Thin Pad area of the 
Pad Definition dialog box
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The Profile Definition
dialog box

A multi-contoured sketch Extruded contours

• Extruding the Sketch by Selecting the Profile Using the Profile
Definition Dialog Box
• To create a feature by selecting a particular contour from a

multi-contour sketch, draw the sketch and invoke the Pad
Definition dialog box. 

• Right-click on the Selection selection area and choose the
Go to profile definition option.

• The Profile Definition dialog box is displayed, as shown in
the figure.
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• Extruding the Sketch Along a Directional Reference

Sketch to be extruded and 
the directional reference

The extrude feature created 
by extruding a sketch along 
the directional reference
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The Shaft Definition
dialog box

CREATING BASE FEATURES BY REVOLVING SKETCHES
• To create a revolved feature, you first need to draw the sketch

that will be revolved around a center line, which is also known
as axis. 

• Next, exit the Sketcher workbench and choose the Shaft
button from the Sketch-Based Features toolbar; the Shaft
Definition dialog box will be displayed, as shown in the figure.

The sketch to be revolved 
and the axis

The model after creating 
the shaft feature
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• Creating Thin Shaft Features

The model after creating the 
thin shaft feature using an 
open profile

You can also create a thin revolved feature, using the Shaft tool.

DYNAMICALLY ROTATING THE VIEW OF THE MODEL
• CATIA V5 allows you to rotate the view of the model dynamically in the 3D space so that  

the solid model can be viewed from all directions. 

• This tool can be invoked even when you are inside some other tool.
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View of the model being 
rotated using the Rotate
tool

• Rotating the View Using the Rotate Tool

• Rotating the View Using the Compass

The Compass
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MODIFYING THE VIEW ORIENTATION
• To invoke the Quick View toolbar toolbar, choose the down arrow on the right of the  

Isometric View button in the View toolbar.

• The Quick view toolbar is shown in the figure.

• This release of CATIA V5 includes the Named views tools in this toolbar. 

• When you choose the Named views button, the Named Views dialog box will be  
displayed, as shown in the figure.

The Named Views
dialog box

The Quick view toolbar
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The View mode toolbar

DISPLAY MODES OF THE MODEL
• To invoke the View mode toolbar, choose the down arrow on the right of the Shading

with Edges button from the View toolbar.

• The View mode toolbar is displayed in the figure.

• The tools available in the View mode are discussed next:

• Shading (SHD)
When you choose the Shading (SHD) button from the View mode toolbar, the model
will be displayed in the shaded mode.

• Shading with Edges
The Shading with Edges mode is the default mode, in which the model is displayed.
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• Shading with Edges without Smooth Edges
When you choose the Shading with Edges without Smooth Edges button, the 
model will be displayed in shading with edges but the display of the smooth edges 
will be removed.

• Shading with Edges and Hidden Edges

• Shading with Material

When you choose the Shading with Edges and Hidden Edges button, the model 
will be displayed in shading with edges, and hidden edges will also be displayed 
along with the visible edges. 

When you choose the Shading with Material button, the model will be displayed in 
the rendered mode.

• Wireframe (NHR)
When you choose the Wireframe(NHR) button, the model will be displayed in the 
wireframe mode.
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• Customize View Parameters
When you choose the Customize View Parameters button, the Custom View Modes
dialog box will be displayed, as shown in the figure.

The Custom View 
Modes dialog box
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ASSIGNING MATERIAL TO THE MODEL
• CATIA V5, also allows you to assign material to the models in the Part Design

workbench.

• All the physical properties of the material applied to model, are assigned to model. 

The Library (ReadOnly) dialog box The model, after assigning 
Aluminium material
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Tutorial 1
In this tutorial, you will create the model shown in Figure A. Its dimensions are shown 
in Figure B. After creating this model, apply Copper material and then rotate the view 
of the model in the 3D space. (Expected time: 20 min)

Figure A Solid model for 
Tutorial 1

Figure B Views and dimensions 
for Tutorial 1
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1. Start a new file in the Part Design workbench of CATIA V5.

2. Invoke the Sketcher workbench by selecting the yz plane from the specification tree.

3. Draw the sketch using the tools in the Sketcher workbench and then add the required 
geometrical and dimensional constraints, as shown in Figure C, Figure D and Figure E.

Figure C Sketch drawn 
using the Axis and
Profile tool

Figure D The sketch after 
applying all constraints

Figure E Final sketch 
for the base feature
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4. Invoke the Shaft tool to create the shaft feature, as shown in Figure F.

Figure F Final model for Tutorial 1
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5. Assign a material to the model and rotate its view in the 3D space, as shown in Figure G
and Figure H.

Figure G The model after assigning 
the Copper material

Figure H The view of the 
model being rotated

6. Save the file in \My Documents\CATIA\c03 folder and then close it.
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Tutorial 2
In this tutorial, you will create the base feature of the model shown in Figure A by
extruding a sketch drawn on the yz plane. You will then apply the Aluminium material 
to the model and then rotate its view in the 3D space. The dimensions of the model 
are shown in Figure B. (Expected time: 20 min)

Figure A Solid model 
for Tutorial 2

Figure B Views and dimensions 
for Tutorial 2
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1. Start a new file in the Part Design workbench.

2. Select the yz plane from the geometry area and invoke the Sketcher workbench.

3. Draw the sketch of the base feature using the tools in the Sketcher workbench, as shown 
in Figure C, Figure D, Figure E and Figure F.

Figure C One quarter 
of the sketch

Figure D Elements
to be selected
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Figure E Resulting
mirrored sketch

Figure F Resulting
mirrored sketch

4. Apply geometrical and dimensional constraints to the sketch to make it iso-Constraint, as 
shown in  Figure G.

Figure G The Sketch after 
applying all dimensions
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5. Exit the Sketcher workbench and invoke the Pad Definition dialog box.

6. Extrude the sketch to the given depth, as shown in Figure H.

Figure H The model after 
creating the base feature
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8. Save the file in \My Documents\CATIA\c03 folder and then close it.

7. Assign a material to the model and then rotate it in the 3D space, as shown in Figure I.

Figure I The model after 
assigning the Aluminium 
material
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Exercise 1
Create the model shown in Figure A. Its dimensions are shown in Figure B.

(Expected time: 30 min)

Figure A Solid Model 
for Exercise 1

Figure B Views and dimensions 
for Exercise 1
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Exercise 2
Create the model shown in Figure A. Its dimensions are shown in Figure B.

(Expected time: 30 min)

Figure A Solid model for Exercise 2 Figure B Views and dimensions 
for Exercise 2
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Learning Objectives:
• Understand the importance of sketching planes.

• Create reference elements.

• Create drafted filleted pad features.

• Create multi-pad features.

• Use feature termination options.

• Create pocket features.

• Create groove features.

• Extrude and revolve the planar and curved faces.
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IMPORTANCE OF SKETCHING PLANES
• Most mechanical designs consist of multiple features such as sketched features,  

referenced elements, and placed features that are integrated to complete a model. 

• You can select any one of the default planes as the sketching plane to create the  
sketch of the base feature.

A multifeatured model Base feature of the model
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Other features of the final model

REFERENCE ELEMENTS
• The reference elements are the features that have no mass and volume and are used

only to assist you in the creation of the models. 

• You can invoke the tools to create reference elements using the Reference Elements
toolbar, as shown in the figure.

The Reference Elements
toolbar
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• Reference Planes
You need to select other default planes or create new planes to be used as the sketching
plane for other features.

• Default Planes

• Creating New Planes

The Plane Definition dialog box

• The three default planes are: xy, yz, and zx plane. 

• It is recommended that you carefully select the sketching plane for drawing the sketch  
of the base feature, which can be drawn on one of the three datum planes provided by
default.

• To create a new plane, choose the Plane button from  
the Reference Elements (Expanded) toolbar.

• The Plane Definition dialog box is displayed, as
shown in the figure.
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• Creating a Plane at an Offset from Existing Plane/Planar Face

Reference planar face 
and the resulting plane

Reference planar face, 
sketched point, and 
the resulting plane

• Creating a Plane Parallel to an Existing Plane and Passing Through Point
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• Creating a Plane at an Angle/Normal to Plane

Rotation axis, reference 
plane, and the resulting 
plane

• Creating a Plane Through Three Points

Three vertices to be selected 
and the resulting plane
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• Creating a Plane Through two Lines

Vertices to be selected 
and the resulting plane

• Creating a Plane Through Point and Line

The point and line to be selected, 
and the resulting plane
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• Creating a Plane Through Planar Curve

The planar curve to be selected 
and the resulting plane

• Creating a Plane Normal to Curve

The curve to be selected, 
the point to be selected, 
and the resulting plane
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• Creating a Plane Tangent to Surface

The reference surface to be selected, the point 
to be selected, and the resulting plane

• Creating a Plane Using Equation
The Equation option is used to create a plane using the equation Ax+By+Cz = D, where
the values of A, B, C, and D are variable and can be changed to modify the orientation of
the plane.

• Creating a Plane Using a Mean Through Points
The Mean through points option is used to create a plane at an orientation defined by
the mean of selected points.
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• Creating Points
To create points, choose the Point button from the Reference Elements toolbar.
The Point Definition dialog box is displayed, as shown in the figure.

The Point Definition dialog box

• Creating a Point Using Coordinates 

• Creating a Point On Curve
The Coordinates option is used to create a point by specifying the values of its coordinates.

The On Curve option is used to create a point on a selected curve.
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• Creating a Point On Plane

• Creating a Point On Surface
The On plane option is used to create a point on a selected plane.

The On Surface option is used to create a point on a selected surface.

• Creating a Point at the Circle Center
The Circle center option is used to create a point at the center of the selected circle.

• Creating a Point Tangent on Curve

• Creating a Point Between Two Points
The Tangent on curve option is used to create a point tangent to the selected arc.

The Between option is used to create a point between two selected points by defining the
ratio of the distance from the two points.

• Creating Reference Lines
To create reference lines, choose the Line button from the Reference Elements
toolbar; the Line Definition dialog box is displayed.
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OTHER SKETCH-BASED FEATURES
• Creating Drafted Filleted Pad Features

The Drafted Filleted Pad 
Definition dialog box

• Choose the Drafted Filleted Pad button from the Pads
toolbar.

• The Drafted Filleted Pad Definition dialog box will be  
displayed, as shown in the figure.

The sketch to be extruded and the plane 
to be selected as the second limit

The resulting drafted 
filleted pad



CATIA V5R16 for Designers Chapter 4

• Creating Multi-Pad Features

The Multi-Pad Definition
dialog box

• To create a multi-pad feature, choose the Multi-Pad button fromthe Pads toolbar
and then select the sketch to be extruded. 

• The Multi-Pad Definition dialog box is displayed,as shown in the figure.

The multi-loop sketch to 
be extruded

The resulting extruded feature 
using the Multi-Pad tool
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• Other Feature Termination Options
The other feature termination options are:

• Up to next
The Up to next option is used to extrude the sketch from the sketching plane to the next  
surface that intersects the feature.

• Up to last
The Up to last option is used to extrude the sketch up to the last surface of the model
that intersects the feature.

• Up to plane
The Up to plane option is used to extrude the sketch from the sketch plane up to the        
selected plane or the planar face.

• Up to surface
The Up to surface option is used to extrude the sketch from the sketch plane to the  
selected surface or planar face.
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Pad features created using 
different feature termination 
options

• Feature Termination at an Offset
You can also terminate the features at an offset from the planes or faces selected for  
feature termination.

• Creating Pocket Features

The Pocket Definition
dialog box

• To create a pocket feature, draw the sketch and then choose  
the Pocket button from the Sketch-Based Features toolbar    
or from the Pockets toolbar.

• The Pocket Definition dialog box is displayed, as shown in
the figure.



CATIA V5R16 for Designers Chapter 4

The sketch for the pocket feature The resulting pocket feature

Pocket feature with the default 
material removal side selected

Pocket feature after flipping the 
material removal direction
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• Creating Drafted Filleted Pocket Features

The drafted filleted pocket feature

• Creating Multi-Pocket Features

The multi-pocket feature
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• Creating Groove Features

The Groove Definition
dialog box

• To create a Groove feature, draw the sketch and then choose  
the Groove button from  the Sketch-Based Features toolbar.

• The Groove Definition dialog box is displayed, as shown in
the figure.

Sketch for creating 
the groove feature

The resulting groove 
feature
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• Extruding and Revolving Planar and Nonplanar Faces

The Warning Message Window

Face selected to extrude and 
the direction of extrusion

The resulting pad feature
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• Projecting 3D Elements

The projected elements

The Project 3D Element tool is used to project selected 2D or 3D elements on the 
current sketch plane.
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Tutorial 1
In this tutorial, you will create the model shown in Figure A. The views and dimensions of 
the model are shown in Figure B. (Expected time: 30 min)

Figure A Solid model for 
Tutorial 1

Figure B The views and 
dimensions for Tutorial 1
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1. Start a new session of CATIA V5 and start a new file in the Part workbench.

2. Draw the sketch of the base feature on the yz plane, as shown in Figure C.

Figure C The sketch 
of the base feature

3. Extrude the sketch to the required distance using the Pad tool, as shown in Figure D.

Figure D The model after 
creating the base feature
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4. Create the second feature, which is a Pocket feature, as shown in Figure E and Figure F.

Figure E The sketch of 
the second feature

Figure F Model after creating 
the second feature
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5. Create the third feature by extruding the sketch, drawn on a plane at an offset from the 
xy plane, as shown in Figure G, Figure H and Figure I.

Figure G Sketch of 
the third feature

Figure H Surface to 
be selected

Figure I The model after 
creating the third feature
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6. Create the fourth feature, which is a Groove feature, as shown in Figure J and Figure K.

Figure J Sketch of the fourth feature Figure K The model after 
creating the fourth feature
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7. Create the last feature of the model which is the Pocket feature, as shown in Figure L
and Figure M.

Figure L Sketch of 
the fifth feature

Figure M Final model

8. Save the file in \My Documents\CATIA\c04 folder and then close it.
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Tutorial 2
In this tutorial, you will create the model shown in Figure A. Its views and dimensions are 
shown in Figure B. (Expected time: 30 min)

Figure A Model for Tutorial 2 Figure B Views and dimensions 
for Tutorial 2
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1. Start a new file in the Part workbench and draw the sketch of the base feature on the yz 
plane, as shown in Figure C.

Figure C Sketch of the base feature
2. Extrude the sketch to a distance of 40 using the Pad tool, as shown in Figure D.

Figure D Base feature of the model
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3. Create the second feature, which is a pocket feature, as shown in Figure E and Figure F.

Figure E Sketch of the 
second feature

Figure F The model after creating 
the second feature
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4. Create the third feature, by extruding a sketch drawn on the right face of the base feature, 
using the Pocket tool, as shown in Figure G and Figure H.

Figure G Sketch of 
the third feature

Figure H The model after 
creating the third feature



CATIA V5R16 for Designers Chapter 4

5. Create the fourth feature, which is also a pocket feature, as shown in Figure I.

Figure I Final model

6. Save the file in \My Documents\CATIA\c04 folder and then close it.
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Tutorial 3
In this tutorial, you will create the model shown in Figure A. Its views and dimensions are 
shown in Figure B. (Expected time: 45 min)

Figure A Model for 
Tutorial 3

Figure B Views and dimensions 
for Tutorial 3
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1. Start a new file in the Part workbench and create the base feature of the model by extruding
the sketch drawn on yz plane, as shown in Figure C and Figure D.

Figure C Sketch of the base feature Figure D Base feature 
of the model
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2. Create the second feature by extruding the sketch drawn on the front face of the base 
feature, as shown in Figure E and Figure F.

Figure E Sketch of the second feature Figure F Model after creating 
the second feature
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3. Create the third feature by extruding a rectangular sketch drawn on the front face of the 
base feature, as shown in Figure G and Figure H.

Figure G Sketch of 
the third feature

Figure H Model after creating 
the third feature
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4. Create the fourth feature by extruding the circular sketch to both the sides of the sketching 
plane. The sketch for this feature will be drawn on the front face. 

5. Create the fifth feature by extruding the sketch drawn on the front face of the fourth feature 
using the Pocket tool.

6. Create the sixth feature by extruding the sketch drawn on the top face of the third feature 
using the Pocket tool. The final model is shown in Figure I.

Figure I Final model

7. Save the file in \My Documents\CATIA\c04 folder and then close it.
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Exercise 1
Create the model shown in Figure A. Its views and dimension are shown in Figure B.

(Expected time: 30 min)

Figure A Model for Exercise 1 Figure B Views and dimensions for Exercise 1
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Exercise 2
Create the model shown in Figure A. Its views and dimension are shown in Figure B.

(Expected time: 30 min)

Figure A Model for Exercise 2 Figure B Views and dimensions 
for Exercise 2
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Learning Objectives:
• Create holes using the Hole tool.

• Create fillet features.

• Create chamfer features.

• Add draft to the faces of the models.

• Create a shell feature.



CATIA V5R16 for Designers Chapter 5

ADVANCED MODELING TOOLS
• Creating Hole Features

• The preview of the hole feature is displayed, along with the Hole Definition dialog
box.

• The Hole Definition dialog box is shown in the figure.

The Hole Definition dialog box
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• Creating a Simple Hole

Types of bottom termination 
options for a hole feature

Base plate with holes created 
using the Hole tool
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• Creating a Threaded Hole

The Hole Definition dialog box after 
selecting the Threaded radio button

• To create the threaded hole, invoke the Thread Definition tab from the Hole Definition
dialog box. 

• By default, the Threaded radio button is cleared. 

• Select the Threaded radio button to invoke the options available in the Thread Definition
tab.
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• Creating a Tapered Hole

The Hole Definition dialog box after 
selecting the Tapered option from 
the drop-down list in the Type tab

To create a tapered hole, invoke the Type tab of the Hole Definition dialog box and
select the Tapered option from the drop-down list, as shown in the figure.
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• Creating a Counterbored Hole
To create a counterbored hole, select the Counterbored option from the drop-down list in
the Type tab of the Hole Definition dialog box, as shown in the figure.

The Hole Definition dialog box after selecting 
the Counterbored option from the drop-down 
list in the Type tab

The sectional view of 
counterbored hole

The base plate with 
counterbored holes
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• Creating a Countersunk Hole

The Hole Definition dialog box, after 
selecting the Countersunk option from 
the drop-down list in the Type tab

To create a countersunk hole, select the Countersunk option from the drop-down list in
the Type tab, as shown in the figure.

The sectional view of the 
countersunk hole

Spacer plate with the 
countersunk holes
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• Creating a Counterdrilled Hole

The Hole Definition dialog box, after selecting 
the Counterdrilled option from the drop-down 
list in the Type tab

To create a counterdrilled hole, select the Counterdrilled option from the drop-down list
in the Type tab; as shown in the figure.

The sectional view of the 
counterdrilled hole

The spacer plate with the 
counterdrilled holes
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• Creating Fillets
Choose the black arrow on the right of the Edge Fillet button in the Dress-Up Features
toolbar; the Fillets toolbar is invoked, as is shown in the figure.

The Fillets toolbar
• Creating an Edge Fillet

The Edge Fillet Definition dialog box

• To create an edge fillet, choose the Edge Fillet button from the Fillets toolbar. 

• The Edge Fillet Definition dialog box is displayed, as shown in the figure.
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Face to be selected Resulting fillet

Edge selected to be filleted Resulting edge fillet
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• Managing Selected Entities
To manage the entities in the current selection set, choose the Selection Filter button
on the right of the Object(s) to fillet selection area; the Fillet objects dialog box is
displayed.

• Managing the Fillet Propagation

Edge selected to 
be filleted

Fillet using the tangent 
propagation

Fillet using the minimal 
propagation
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• Trimming the Overlapping Fillets

Fillet with the Trim ribbons
check box cleared

Fillet with the Trim ribbons
check box selected
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• Selecting the Edges to Keep

Edges distorted to accommodate 
the fillet radius

The model after selecting 
the edges to be keep
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• Setting the Limits of the Fillet

Edge to be filleted and the limiting 
element

Resulting fillet
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• Setback Fillet by Blending the Corners

Edges to be selected Preview of the setback fillet Resulting setback fillet
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• Creating Variable Radius Fillets

Expanded form of the Variable Radius Fillet 
Definition dialog box

To create variable radius fillet, choose the Variable Radius Fillet button from the 
Fillets toolbar; the Variable Radius Fillet Definition dialog box is displayed, as 
shown in the figure.
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Variable radius fillet with the 
Cubic option selected

Variable radius fillet with the 
Linear option selected

Variable radius fillet created by specifying 
radii at the two end points of the edge

Variable radius fillet after defining 
additional control points
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• Creating Face-Face Fillets

The Face-Face Fillet 
Definition dialog box

• To create a face fillet, choose the Face-Face Fillet button from the Fillets toolbar.

• The Face-Face Fillet Definition dialog box is displayed, as shown in the figure.

Faces to be selected Resulting face-face fillet
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• Creating Tritangent Fillets

The Tritangent Fillet 
Definition dialog box

Faces to be selected Resulting tritangent fillet

To create a tritangent fillet, choose the Tritangent Fillet button from the Fillets toolbar, 
the Tritangent Fillet Definition dialog box is displayed, as shown in the figure. 
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• Creating Chamfers

The Chamfer Definition
dialog box

Edge to be selected Resulting chamfer

To chamfer the edges of the model, choose the Chamfer button from the Dress-Up
Features toolbar; the Chamfer Definition dialog box is displayed, as shown in the
figure.
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• Adding a Draft to the Faces of the Model
• A draft is defined as the process of adding a taper angle to the faces of the model. 

• Adding draft to the faces of the model is one of the most important operations, especially,
while creating the components that needs to be cast, mold, or formed. 

• The Part workbench of CATIA V5 provides you with various tools to draft faces of the
model.
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• Adding a Simple Draft

The Draft Definition
dialog box

Faces to be selected Resulting drafted faces

• To add a draft, choose the Draft Angle button from the Drafts toolbar. 

• The Draft Definition dialog box will be displayed, as shown in the figure. 
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Faces and planes to be selected Resulting drafted faces
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• Defining the Parting Element While Adding Drafts to the Faces

Faces drafted with the Parting 
= Neutral check box selected.

Faces drafted with the Draft both 
sides check box selected
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References to be selected Resulting drafted faces

Limiting faces to be selected Resulting drafted face



CATIA V5R16 for Designers Chapter 5

• Adding Drafts using the Reflect Line

The Draft Reflect Line 
Definition dialog box

Face and plane to be selected Resulting draft feature

• To create this type of draft feature, choose the Draft Reflect Line button from the
Drafts toolbar.

• The Draft Reflect Line Definition dialog box is displayed, as shown in the figure.
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• Adding a Variable Angle Draft

The Draft Definition
dialog box

References to be selected Face after adding draft

• To create a variable angle draft, choose the Variable Angle Draft from the Drafts
toolbar.

• The Draft Definition dialog box is displayed, as shown in the figure.
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• Creating a Shell Feature

The Shell Definition
dialog box

Faces to be selected for 
removal

Resulting shelled model

• To create a shell feature, choose the Shell button from the Dress-Up Features
toolbar.

• The Shell Definition dialog box is displayed, as shown in the figure.
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• Creating a Multithickness Shell

Faces to be selected Resulting shelled model
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Tutorial 1
In this tutorial, you will create the model of the nozzle of a vacuum cleaner shown in 
Figure A. Its views and dimensions are shown in Figure B. (Expected time: 45 min)

Figure A Model of the Vacuum 
Cleaner for Tutorial 1

Figure B Views and dimensions of 
the Vacuum Cleaner for Tutorial 1
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1. Start a new file in the Part workbench and create the base feature of the model by extruding
the sketch along the selected direction, as shown in Figure C through Figure G.

Figure C Reference sketch Figure D Point to be placed
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Figure E Points to be selected 
to create plane

Figure F Sketch of the base feature

Figure G Model after creating 
the base feature
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2. Create the second feature of the model by extruding a sketch using the Drafted Fillet Pad
tool, as shown in Figure H and Figure I.

Figure H Sketch for the second feature Figure I Resulting
second feature
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3. Create the third feature of the model, which is a cut feature. It will be used to remove the 
unwanted portion of the second feature, as shown in Figure J and Figure K.

Figure J Sketch for the 
Pocket feature

Figure K Model after creating 
the third feature
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4. Apply fillets to all edges of the model, as shown in Figure L, Figure M, Figure N and
Figure O.

Figure L Edges to be selected Figure M The model after 
creating the fillet
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Figure N Edges not to be selected Figure O Model after 
creating second fillet



CATIA V5R16 for Designers Chapter 5

4. Shell the model using the Shell tool, as shown in Figure P and Figure Q.

Figure P Faces to be removed Figure Q Final model after shelling

5. Save the file in \My Documents\CATIA\c05 folder and then close it.
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Tutorial 2
In this tutorial, you will create the model of the plastic cover shown in Figure A. Its views 
and dimensions are shown in Figure B. (Expected time: 30 min)

Figure A Model of the Plastic 
Cover for Tutorial 2

Figure B Views and dimensions of the 
Plastic Cover  for Tutorial 2
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1. Create the base feature of the model by extruding the sketch drawn on zx plane equally to 
both the sides of the sketch plane, as shown in Figure C and Figure D.

Figure C Sketch of the base feature Figure D The model after creating 
the base feature
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2. Create the second feature by extruding the sketch drawn on a plane created at an offset 
distance from the xy plane, as shown in Figure E and Figure F.

Figure E Sketch of 
the second feature

Figure F The mode after creating the 
second feature
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3. Add the draft feature to all faces of the model except the upper and the lower faces, as 
shown in Figure G.

Figure G The model after drafting 
all the vertical faces

4. Fillet the edges of the model, as shown in Figure H through Figure M.

Figure H Edges to be selected Figure I The model after filleting 
the first set of edges
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Figure J Edge to be filleted Figure K The model after 
filleting the second set

Figure L Edges not to be selected Figure M Resulting filleted model
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5. Shell the model using the Shell tool by removing the bottom face of the model, as shown 
in Figure N and Figure O.

Figure N Face to be removed Figure O Resulting shelled model
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6. Create two pocket features to complete the model, as shown in Figure P.

Figure P Final model after creating 
the remaining features

7. Save the file in \My Documents\CATIA\c05 folder and then close it.
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Exercise 1
Create the model of the Clutch Lever shown in Figure A. Its views and  dimensions are 
shown in Figure B. (Expected time: 30 min)

Figure A Model of the Clutch 
Lever for Exercise 1

Figure B Views and dimensions of 
the Clutch Lever for Exercise 1
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Exercise 2
Create the model of the Clamp Stop shown in Figure A. Its views and dimensions are 
shown in Figure B. (Expected time: 60 min)

Figure A Model of the Clamp Stop 
for Exercise 2

Figure B Views and dimensions 
of the Clamp Stop for Exercise 2
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Learning Objectives:
• Edit features using the Definition option.
• Edit features by double-clicking.
• Edit sketches of the sketch-based features.
• Manage features and sketches by cut, copy, and paste functionality.
• Cut, copy, and paste features and sketches from one file to another.
• Copy features using drag and drop.
• Delete features.
• Deactivate features.
• Activate the deactivated features.
• Define features in the work object.
• Reorder features.
• Understand parent child relationships.
• Understand the concept of update diagnose.
• Measure elements.
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EDITING FEATURES OF A MODEL
• Editing is one of the most important aspect of the product design cycle.

• Almost all designs require editing either during their creation or after they are created. 

Base Plate with simple holes Modified Base Plate
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• Editing Using the Definition Option
• Editing by Double-clicking
• Editing the Sketch of a Sketch-based Feature

The Sketch Positioning
dialog box

The editing methods in CATIA V5 are listed next:

• To edit a sketch, select it from the specification tree and invoke
the contextual menu. 

• Move the cursor to the name of the sketch at the bottom of the 
contextual menu and choose the Change Sketch Support
option from the cascading menu. 

• The Sketch Positioning dialog box is displayed, as shown in
the figure.

• Redefining the Sketch Plane of Sketches
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Base feature created 
on the yz plane

The model after redefining the sketch 
plane of the base feature to zx plane

When you redefine the sketch plane of the sketch-based features, sometimes a Warning  
dialog box is displayed, as shown in the figure.

The Warning dialog box
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• Managing Features and Sketches by Cut, Copy, and Paste  
Functionality

The Warnings
dialog box

• Understanding the Concept of Update Diagnose

The Update Diagnosis
dialog box

If the resulting feature merges with the model, the Warnings dialog box is displayed, as
shown in the figure.

Sometime, after editing or modifying a feature, the Update Diagnose dialog box is
displayed, as shown in the figure.
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• Cut, Copy, and Paste Features and Sketches from One File to
Another

• Copying Features Using Drag and Drop

Feature being dragged Resulting pasted feature 
after editing its sketch

Select the fillet that you need to copy from the geometry area and use the CTRL+C keys  
to copy the selected feature.
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Fillet feature being dragged to be pasted on the edge of 
the model in another file
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• Copying and Pasting PartBodies

The Paste Special dialog box

• To use this option, copy the PartBody from one of the files and the select the PartBody
in the other file in which you need to paste it. 

• Right-click to invoke the contextual menu and choose the Paste Special option.

• The Paste Special dialog box is displayed, as shown in the figure.
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• Deleting Unwanted Features

The Delete dialog box

• Deactivating Features

The Deactivate dialog box

• Activating the Deactivated Features

The Activate dialog box
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• Defining Features in Work Object
Defining a feature in the work object is as a process in which you rollback the model to
an earlier stage.

• Reordering the Features

The Feature Reorder
dialog box

Model with through holes 
on the top face

Reordering is defined as a process of changing the order, in which the features were
created in the model.

Model after shelling The model after reordering 
the Shell feature
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• Understanding Parent Child Relationships
Invoke the contextual menu and choose the Parents/Children option; the Parents and  
Children dialog box is displayed, as shown in the figure.

The Parents and Children
dialog box
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MEASURING ELEMENTS
• The Part workbench of CATIA V5 also provides you with

the tools to measure distance, angle, radius, area, and
inertia.

• To measure these elements, you can use the tools  
available in the Measure toolbar, as shown in the figure. The Measure toolbar

• Measuring Between Elements

The Measure Distance
dialog box

To measure the distance and angle between two elements,  
choose the Measure Between button from the Measure
toolbar;the Measure Between dialog box is displayed, as  
shown in the figure.
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• Measuring Items

The Measure Item dialog box

• To measure elements using this tool, choose the Measure Item button from the  
Measure toolbar.

• The Measure Item dialog box is displayed, as shown in the figure.
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• Measuring Inertia

The Measure Inertia dialog box The expanded Measure Inertia
dialog box

Choose the Measure Inertia button from the Measure tool; the Measure Inertia
dialog
box is displayed, as shown in the figure.
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Tutorial 1
In this tutorial, you will create the model of the Bottom Seat shown in Figure A. Its views 
and dimensions are shown in Figure B. After creating this model, you will perform the 
following modifications. 

1. Change the two holes on the front face of the model to countersunk holes.

2. Change the hole on the right face of the model to counterbored hole.

3. Change the curved pocket feature on the upper face of the model to a rectangular slot. 
(Expected time: 45 min)

Figure A Model of the Bottom
Seat for Tutorial 1

Figure B Views and dimensions of Tutorial 1
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The model, after modifications, is as shown in Figure C.

Figure C The model after 
making the modifications
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1. Start a new file in the Part workbench of CATIA V5 and create the base feature of the model 
by extruding the sketch drawn on the zx plane, as shown in Figure D and Figure E.

Figure D Sketch of the base feature Figure E The model after 
creating the base feature
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2. Create a pocket feature by extruding a sketch drawn on the front face of the base feature, 
as shown in Figure F and Figure G.

Figure F Sketch of the second 
feature

Figure G The model after creating 
the second feature
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3. Fillet the right and left edges of the model, as shown in Figure H.

4. Create the hole features on the front and right faces of the model, as shown in Figure H.

Figure H The model after creating 
all features
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5. Edit the model, as shown in Figure I and Figure J.

Figure I Sketch after modifications Figure J Model after modifications

6. Save the file with the file name c06tut1.CATPart within the c06 folder.
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Tutorial 2
In this tutorial, you will create the model of the Vice Jaw shown in Figure A. Its views 
and dimensions are shown in Figure B. After creating this model, you will edit some of 
its dimensions. Figure C shows the views and the dimensions that need to be edited.     

(Expected time: 30 min)

Figure A Model of the Vice 
Jaw for Tutorial 2

Figure B Views and dimensions 
of the Vice Jaw for Tutorial 2
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Figure C Dimensions of the Vice Jaw to 
be modified
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1. Create the base feature of the model by extruding the sketch drawn on the zx plane, as 
shown in Figure D and Figure E.

Figure D Sketch of the 
base feature

Figure E Model after creating 
the base feature
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2. Create the second feature of the model by extruding a sketch drawn on the front face of the 
base feature, as shown in Figure F and Figure G.

Figure F Sketch of the second 
feature

Figure G Model after creating 
the second feature
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3. Create the third feature of the model by extruding a rectangular sketch drawn on the front 
face of the base feature, as shown in Figure H and Figure I.

Figure H Sketch of the third feature Figure I The model after 
creating the third feature
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4. Create the holes using the Hole tool, as shown in Figure J.

5. Apply fillet to the edges of the model, as shown in Figure K.

Figure J The model after creating 
the counterbore hole

Figure K Final model after 
creating all the features
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6. Modify the model, as shown in Figure L.

Figure L The model after 
modifying the design

7. Save the file with the file name c06tut2.CATPart within the c06 folder.
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Tutorial 3
In this tutorial, you will create the model shown in Figure A. Its views and dimensions 
are shown in Figure B. After creating this model, you will edit its design by replacing 
the counterbored holes with countersunk holes. Also, replace the rectangular slot by 
an elongated slot. Figure C shows the views and dimensions of the model, after 
editing. (Expected time: 45 min)

Figure A Model for Tutorial 3 Figure B Views and dimensions 
for Tutorial 3
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Figure C Final edited model
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3. Create a pad feature by extruding a sketch drawn on the front face of the base feature, 
as shown in Figure E.

Figure E Second feature 
of the model

1. Start a new file in the Part Design workbench.

2. Create the base feature of the model by extruding the sketch drawn on the yz plane, as 
shown in Figure D.

Figure D Base feature 
of the model
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4. Create the third and forth features by extruding the sketch drawn on the front face of the 
second feature, as shown in Figure F and Figure G.

Figure F Third feature of 
the model

Figure G Model after creating 
the Pocket feature
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5. Create the holes using the Hole tool and fillet the required edges, as shown in Figure H.

Figure H The final model after 
creating all the features
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6. Edit the design of the model, as shown in Figure I and Figure J.

Figure I Edited sketch of 
the pocket feature

Figure J Final edited model

7. Save the file with the file name c06tut3.CATPart within the c06 folder.
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Exercise 1
Create the model shown in Figure A. Its view and dimensions are shown in Figure B.

(Expected time: 45 min)

Figure A Model for Exercise 1 Figure B Views and dimensions 
for Exercise 1
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Exercise 2
Create the model of the Plummer Block Casting shown in Figure A. The views and 
dimensions of the model are shown in Figure B. (Expected time: 30 min)

Figure A Model for Exercise 2 Figure B Views and dimensions 
for Exercise 2
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Learning Objectives:
• Translate bodies.

• Rotate bodies.

• Create symmetry features and bodies.

• Mirror features and bodies.

• Create rectangular patterns.

• Create circular patterns.

• Create user patterns.

• Scale models.

• Work with additional bodies.

• Add stiffeners to a model.
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TRANSFORMATION FEATURES
• Translating Bodies

The Transformations toolbar

• To translate the current body, invoke the Transformations toolbar, by    
choosing the down arrow on the right of the Translation button from the  
Transformation Features toolbar.

• The Transformations toolbar is shown in the figure.
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• Choose the Translation button from the Transformations toolbar. The Question dialog
box is displayed, as shown in the figure.

The Question dialog box The Translate Definition
dialog box

Plane selected as directional reference Resulting translated body
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• Rotating Bodies

Edge to be selected as 
rotation axis

Resulting rotated body

• Choose the Rotation button from the Transformations toolbar; the Question
dialog box is displayed. 

• Choose the Yes button from this dialog box; the Rotate Definition dialog box is
displayed, as shown in the figure.

The Rotation Definition
dialog box
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• Creating Symmetry Features

The Symmetry Definition
dialog box

Symmetry reference to be 
selected

Resulting symmetry feature

• To invoke this tool, choose the Symmetry button from the Transformations toolbar
and then choose the Yes button from the Question dialog box. 

• The Symmetry Definition dialog box is displayed, as shown in the figure.
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• Mirroring Features and Bodies

The Mirror Definition
dialog box

Feature and the mirror 
plane to be selected

Resulting mirrored feature

To mirror the selected feature, select it from geometry area or from the specification 
tree and choose the Mirror button from the Transformation Features toolbar; the 
Mirror Definition dialog box is displayed, as shown in the figure.
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Face to be selected as mirror plane Resulting mirrored model
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• Creating Rectangular Patterns

Figure A The Patterns toolbar Figure B The Rectangular Pattern
Definition dialog box

• To create the rectangular pattern, choose the Rectangular Pattern button from the
Patterns toolbar, as shown in Figure A.

• The Rectangular Pattern Definition dialog box is displayed, as shown in Figure B.
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Feature and the edge 
to be selected

Resulting pattern Rectangular pattern in 
two directions pattern
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Directional references 
to be selected

Resulting pattern of the PartBody

Pattern with the Keep specifications
check box cleared

Pattern with the Keep specifications
check box selected
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Patterned feature without 
skipping any instance

Patterned feature after skipping 
some of the instances

The expanded Rectangular Pattern
Definition dialog box



CATIA V5R16 for Designers Chapter 7

Feature to be pattern Position of the parent 
feature in the pattern

New position of the parent 
feature

Rotated pattern
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• Creating Circular Patterns

The Circular Pattern Definition
dialog box

• To arrange features or the current body in a circular manner, choose the Circular
Pattern button from the Patterns toolbar.

• The Circular Pattern Definition dialog box is displayed, as shown in the figure.
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Feature to be patterned and 
the reference element to be 
selected

Resulting patterned feature

The Circular Pattern Definition dialog box 
after invoking the Crown Definition tab
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Various parameters used to define 
the crown in the pattern

Resulting pattern after defining 
the crown parameters

Pattern with the Radial alignment
of instance(s) check box selected

Pattern with the Radial alignment
of instance(s) check box cleared
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• Creating User Patterns

The User Pattern 
Definition dialog
box

Features and the reference sketch Resulting pattern

• To create a user pattern, select the feature to be patterned and then choose the
User Pattern button from the Patterns toolbar.

• The User Pattern Definition dialog box is displayed, as shown in the figure.
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• Scaling Models

WORKING WITH ADDITIONAL BODIES

• To scale a model, choose the Scaling button from the Transformation Features
toolbar.

• The Scaling Definition dialog box is displayed, as shown in the figure.

• The Part workbench of CATIA V5 provides you with a tool to insert new bodies in 
the

current model. 

• You can create features in the newly created body and then perform the boolean  
operations on two or more than two part bodies

The Scaling Definition
dialog box
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• Inserting a New Body

Newly inserted body

• To insert a new body, choose the Body button from the Insert toolbar.

• A new body named Body.2 is added under the current body in the specification tree,
as shown in the figure.

• Inserting Features in the Assemble Feature
To assemble the feature, select it and then choose the Assemble Feature button
from the Insert toolbar.

The specification tree
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• Applying Boolean Operations to Bodies
After inserting the bodies, you can apply the boolean operations, such as addition of two  
bodies, subtraction of one body from the other, retaining the intersection portion of two   
bodies, and so on.
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• Assembling Bodies

The Assemble dialog box

• To assemble the two bodies together, choose the Assemble button from the
Boolean Operations toolbar.

• The Assemble dialog box is displayed, as shown in the figure.
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Pocket body and the 
parent body

Resulting assembled body

Bodies to be assembled Resulting assembled body
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• Adding Bodies

The Add dialog box

Bodies to be added Resulting body

• The Add tool is used to add the selected bodies together. 

• When you invoke this tool, the Add dialog box is displayed, as shown in the figure.



CATIA V5R16 for Designers Chapter 7

• Subtracting Bodies

The Remove dialog box

Body to be removed 
and the parent body

Resulting body

• The Remove tool is used to subtract the selected body from another body. 

• When you invoke this tool, the Remove dialog box is displayed, as shown in the
figure.
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• Intersecting Bodies

The Intersect dialog box

Body to be selected Resulting body

• The Intersect tool is used to retain the common portion of two intersecting bodies  
and remove the other portions of the selected bodies. 

• When you invoke this tool, the Intersect dialog box is displayed, as shown in the
figure.
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• Trimming Bodies

The Trim Definition
dialog box

Body to be trimmed and the face 
selected to specify the portion of 
the body to be retained

Resulting trimmed body

• On invoking this tool, you will be prompted to select the body to trim, therefore do so. 

• Note that the parent body can not be trimmed. 

• The Trim Definition dialog box is displayed, as shown in the figure.
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• Removing Lumps

The Remove Lump 
Definition (Trim)
dialog box

Face selected to be removed Resulting body after 
removing the lump

• When you invoke this tool, you are prompted to select the body to be trimmed. 

• Select the body from the geometry area; the Remove Lump Definition (Trim) dialog
box is displayed, as shown in the figure.
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ADDING STIFFENERS TO THE MODEL
• Stiffeners are generally added to increase the strength of the components under the  

increased loading conditions. 

• To add a stiffener, choose the Stiffener button from the Advanced Extruded
Features toolbar.

• The Stiffener Definition dialog box is displayed, as shown in the figure.

The Stiffener Definition
dialog box
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Sketch for the stiffener Resulting stiffener

Sketch for the stiffener Resulting stiffener
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Tutorial 1
In this tutorial, you will create the model of the Soap Case shown in Figure A. Its views 
and dimensions are shown in Figure B. (Expected time: 45 min)

Figure A Model of the Soap Case 
for Tutorial 1

Figure B Views and dimensions 
of the Soap Case for Tutorial 1



CATIA V5R16 for Designers Chapter 7

1. Create the base feature of the model, as shown in Figure C.

2. Apply draft to faces of the base feature, as shown in Figure D.

Figure C Base feature of 
the model

Figure D The model after 
creating the draft feature
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3. Create a pocket feature to shape the lower portion of the model, as shown in Figure E.

4. Fillet the edges of the model, as shown in Figure F and Figure G.

Figure E The model after creating 
the pocket feature

Figure F Edges to be selected Figure G The model after 
filleting the edges
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5. Shell the model and remove the top face.

6. Create a pocket feature that will be used as a vent for removing water from the Soap Case, 
as shown in Figure H.

Figure H The model after creating 
the pocket feature
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7. Pattern the newly created pocket feature, as shown in Figure I and Figure J.

Figure I Edge to be selected 
as reference

Figure J The model after creating 
the pattern
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8. Create the standoff for the Soap Case using the Pad, Draft, and the Edge Fillet tools,
as shown in Figure K.

Figure K The model after 
creating the standoff
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9. Pattern the standoff, as shown in Figure L and Figure M.

Figure L Edges to be selected 
as reference

Figure M Final model 
after patterning

10. Save the file in \My Documents\CATIA\c07 folder and then close it.
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Tutorial 2
In this tutorial, you will create the model of the Motor Cover shown in Figure A. Its views 
and dimensions are shown in Figure B. (Expected time: 45 min)

Figure A Model of the Motor 
Cover for Tutorial 2

Figure B Views and dimensions 
of the Motor Cover for Tutorial 2
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1. Create the base feature of the model by revolving a sketch drawn on the yz plane, as 
shown in Figure C.

2. Shell the model and remove the bottom face of the model, as shown in Figure D.

Figure C Base feature 
of the model

Figure D The model after 
creating the shell feature
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3. Create the pad feature on the outer periphery of the base feature, as shown in Figure E.

4. Pattern the newly created pad feature using the Circular Pattern tool, as shown in Figure F.

Figure E The model after 
creating the pad feature

Figure F The model after 
patterning the pad feature
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5. Create the pocket feature on the top face of the base feature, as shown in Figure G.

6. Pattern the pocket feature using the Rectangular Pattern tool, as shown in Figure H.

Figure G The model 
after creating the 
pocket feature

Figure H The model 
after patterning the 
pocket feature
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7. Create the remaining features of the model, as shown in Figure I.

Figure I Final model of the 
Motor Cover

8. Save the file in \My Documents\CATIA\c07 folder and then close it.
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Exercise 1
Create the model of the Bracket shown in Figure A. Its views and dimensions are shown 
in Figure B. (Expected time: 45 min)

Figure A Model of the 
Bracket for Exercise 1

Figure B Views and dimensions 
of the Bracket for Exercise 1
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Exercise 2
Create the model of the Valve Body shown in Figure A. Its views and dimensions are 
shown in Figure B. (Expected time: 45 min)

Figure A Model of Valve Body 
for Exercise 2

Figure B The views and dimensions 
of the Valve Body for Exercise 2
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Learning Objectives:
• Create rib features.

• Create slot features.

• Create multi-section solid features.

• Create removed multi-section solid features.
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ADVANCED MODELING TOOLS
• Creating Rib Features

To create a rib feature, choose the Rib button from the Sketch-Based Features
toolbar; the Rib Definition dialog box is displayed, as shown in the figure.

The Rib Definition
dialog box

Profile and the center curve to 
be selected

Resulting rib feature
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Unattached profile and the center curve Resulting rib feature

Closed profile and closed 
center curve

Resulting rib feature
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• Defining the Pulling Direction

The profile, center curve, and the 
pulling direction to be selected

The rib feature without 
the pulling direction

The rib after defining 
the pulling direction



CATIA V5R16 for Designers Chapter 8

• Merging the End Faces of the Rib

The profile and center curve

Rib feature with the Merge rib’s
end check box cleared

Rib feature with the Merge rib’s
end check box selected
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• Creating Thin Rib Features

The Thin Rib area of 
the Rib Definition
dialog box

A thin rib feature

You can create a thin rib feature by selecting the Thick Profile check box from the Rib
Definition dialog box.
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• Defining the Reference Surface

The profile, center curve, 
and reference surface to 
be selected

Rib feature with the Keep Angle
option selected from the Profile
control area

Rib feature after defining 
the reference surface

A reference surface can be defined for creating the rib feature.



CATIA V5R16 for Designers Chapter 8

• Creating Rib Features Using Open Profile and Open Center Curve

Profile and the center curve Resulting rib feature
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• Creating Slot Features

The Slot Definition
dialog box

Profile and the center curve

• The Slot tool is used to remove the material by sweeping a profile along a center  
curve.

• To create this feature, choose the Slot button from the Sketch-Based Features
toolbar; the Slot Definition dialog box is displayed, as shown in the figure.
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Resulting rib feature The rib feature, after selecting 
the Merge slot’s ends check
box
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• Creating Multi-sections Solid Features

The Multi-sections Solid 
Definition dialog box

Sections selected to create 
the multi-sections solid

Resulting multi-sections 
solid feature

• To create a loft feature, choose the Loft button from the Sketch-Based Features
toolbar.

• The Multi-sections Solid Definition dialog box is displayed, as shown in the figure.
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• Multi-sections Solid Section with Unequal Number of Vertices

Figure A The Multi-sections Solid Definition
dialog box after invoking the Coupling tab

The Coupling dialog box

• To create this type of feature, invoke the Multi-sections Definition dialog box, and
select the triangular and the rectangular sections. 

• Set the closing points, if required.

• Now, invoke the Coupling tab, as shown in Figure A.
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Sections, closing points, and 
couplings

Resulting multi-sections 
solid feature
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• Creating a Multi-sections Solid of Circular Section with a Polygonal

Sections, closing points, and 
couplings

Resulting multi-sections 
solid feature
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• Creating a Multi-sections Solid of the Sections Along a Spine

The Multi-sections Solid Definition dialog
box after invoking the Spine tab

The sections and the spine to 
be selected

To create a multi-sections solid feature using this option, invoke the Spine tab of the 
Multi-sections Solid Definition dialog box, as shown in the figure.
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Multi-sections solid feature 
without selecting the spine

Multi-sections solid feature after 
selecting the spine

• Creating a Multi-sections Solid Feature with Guides

The sections and guides Resulting multi-section 
solid feature
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• Creating Removed Multi-sections Solid Features

Sections and the spine to 
be selected

Resulting feature

When you invoke this tool, the Removed Multi-sections Solid Definition dialog
box is displayed, as shown in the figure.

The Removed Multi-sections 
Solid Definition dialog box
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Tutorial 1
In this tutorial, you will create the model of the Upper Housing as shown in Figure A.
Its views and dimensions are shown in Figure B. (Expected time: 1 hr)

Figure A Model of the Upper Housing 
for Tutorial 1

Figure B Views and dimensions of 
the Upper Housing for Tutorial 1
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1. Create the base feature of the model, as shown in Figure C.

2. Create the rib feature, as shown in Figure D through Figure G.

Figure D Sketch of the center curve Figure E Sketch of the profile

Figure C Base feature 
of the model
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Figure F Sketches for the rib feature Figure G Model after creating 
the rib feature
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3. Create the multi-sections solid feature, as shown in Figure H and Figure I.

Figure H Second section of the 
multi-sections solid  feature

Figure I Model after creating the 
multi-sections solid feature



CATIA V5R16 for Designers Chapter 8

4. Fillet the edges of the model, as shown in Figure J.

5. Shell the model and remove the bottom and the left planar face of the model, as shown 
in Figure K.

Figure J Model after 
filleting the edges

Figure K Model after shelling
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6. Create the other features to complete the model, as shown in Figure L.

Figure L Final model of the Upper Housing

7. Save the file in \My Documents\CATIA\c08 folder and then close it.
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Tutorial 2
In this tutorial, you will create the model of the Helical Gear shown in Figure A. Its views 
and dimensions are shown in Figure B. (Expected time: 1 hr)

Figure A Model of the Helical 
Gear for Tutorial 2

Figure B Views and dimensions for 
Tutorial 2
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1. Create the base feature of the model, as shown in Figure C.

Figure C Base feature of the model
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2. Create a pad feature on the right of the base feature and then pattern it using the Circular 
Pattern tool, as shown in Figure D and Figure E.

Figure D The model after creating 
the pad feature

Figure E The model after creating 
the pattern
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3. Draw the sketch of the first section of gear tooth on the front face of the base feature.

4. Draw the sketch of the second section of the gear on a plane that is at an offset distance 
from the front plane of the base feature. This sketch is the 75% scaled sketch of the first 
section and is rotated at an angle of 15-degree.

5. Draw the sketch of the third section of the gear on a plane that is at an offset distance 
from the plane created earlier. This sketch is the 50% scaled sketch of the section and 
is rotated at an angle of -15-degree, as shown in Figure F.

Figure F The model after 
drawing all the sections
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7. Save the file in \My Documents\CATIA\c08 folder and then close it.

6. Create a multi-sections solid feature using three sections, as shown in Figure G.

Figure G Final model
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Tutorial 3
In this tutorial, you will create the model of the Mouse Cover as shown in Figure A. Its 
views and dimensions are shown in Figure B. (Expected time: 30 min)

Figure A Model of the Mouse Cover 
for Tutorial 2

Figure B Drawing views and 
dimensions for Tutorial 2
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1. Draw sketches for creating a multi-sections solid feature with guides. The sketches include 
two sections and three guides, as shown in Figure C through Figure H.

Figure C Sketch of the 
first guide

Figure D Sketch of the 
second guide

Figure E Sketch of the third 
guide



CATIA V5R16 for Designers Chapter 8

Figure F Sketch of the first 
section

Figure G Sketch of the 
second section

Figure H Model after 
drawing all sketches



CATIA V5R16 for Designers Chapter 8

2. Create the base feature by creating multi-section solid with guides, as shown in Figure I 
and Figure J.

Figure I Sections and guides 
to be selected

Figure J Base feature of the model
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3. Fillet the edges of the base feature, as shown in Figure K through Figure N.

Figure K Edges to be filleted Figure L Model after filleting the edges

Figure M Edge to be filleted Figure N The model after 
filleting the selected edge
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4. Shell the model by removing the front and the bottom face of the model, as shown 
in Figure O.

Figure O Final model

5. Save the file in \My Documents\CATIA\c08 folder and then close it.
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Exercise 1
Create the model of the Angle Flange shown in Figure A. Its views and dimensions are 
shown in Figure B. (Expected time: 45 min)

Figure A Model of the Angle 
Flange for Exercise 1

Figure B Views and dimensions 
for Exercise 1
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Exercise 2
Create the model of the Carburetor Cover shown in Figure A. Its views and dimensions 
are shown in Figure B. (Expected time: 45 min)

Figure A Model of Carburetor 
Cover for Exercise 2

Figure B Views and dimensions 
for Exercise 2
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Learning Objectives:
• Create wireframe geometry.

• Create extruded surfaces.

• Create revolved surfaces.

• Create spherical surfaces.

• Create offset surfaces.

• Create swept surfaces.

• Create fill surfaces.

• Create multisections surfaces.

• Create blend surfaces.

• Split surfaces.

• Trim surfaces.

• Join surfaces.
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NEED OF SURFACE MODELING
• The product and industrial designers give importance to product styling and providing a

unique shape to components.

• Generally, this is done to make sure that the product looks attractive and presentable.

• Surface models are three-dimensional models with no thickness and unlike solid models,
they do not have mass properties.
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• Starting Wireframe and Surface Design Workbench

WIREFRAME AND SURFACE DESIGN WORKBENCH
The Wireframe and Surface Design workbench provides the tools to create wireframe 
construction elements during preliminary design and enrich existing 3D mechanical part 
design with wireframe and basic surface features.

CREATING WIREFRAME ELEMENTS
• The wireframe construction elements aid in creating surfaces. 

• The sketches drawn in sketcher workbench can also be used to create surfaces.

• Start a new session of CATIA V5 and close the new product file, which is opened by  
default.

• Next, choose Start > Mechanical Design > Wireframe and Surface Design from the
menu bar to start a new file in the Wireframe and Surface Design workbench.
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• Creating Circles

The Circle Definition dialog box

Choose the Circle button from the Wireframe toolbar; the Circle Definition dialog
box is displayed, as shown in the figure.
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• Creating Splines

Figure A The Curve toolbar Figure B The Spline Definition
dialog box

• Choose the down arrow on the right of the Spline button to invoke the Curves
toolbar, as shown in Figure A, and then choose the spline button.

• The Spline Definition dialog box is displayed, as shown in the Figure B.
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• Creating Helix

The Helix Curve Definition
dialog box

The helix without specifying 
the taper angle

The helix with a specified 
taper angle

When you invoke the Helix tool, the Helix Curve Definition dialog box will be 
displayed, as shown in the figure.
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CREATING SURFACES
• Creating Extruded Surfaces

The Extruded Surface 
Definition dialog box

The profile to be extruded The resulting extruded surface

Choose the Extrude button from the Surfaces toolbar; the Extrude Surface
Definition dialog box is displayed, as shown in the figure.
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• Creating Revolved Surfaces

The Revolution Surface 
Definition dialog box

The profile and 
revolution axis

Surface revolved through 
an angle of 180-degree

Choose the Revolve button from the Surfaces toolbar; the Revolution Surface
Definition dialog box is displayed, as shown in the figure.
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• Creating Spherical Surfaces

The Sphere Surface 
Definition dialog box

A spherical surface

When you invoke the Sphere tool, the Sphere Surface Definition dialog box is 
displayed, as shown in the figure.
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• Creating Cylindrical Surfaces 

• Creating Offset Surfaces

The Offset Surface Definition
dialog box

Choose the Cylinder button from the Surfaces toolbar; the Cylinder Surface
Definition dialog box is displayed.

• Choose the Offset tool from the Surfaces toolbar.

• The Offset Surface Definition dialog box is displayed, as shown in the figure.
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The Object Repetition
dialog box

An offset surface

• The Repeat object after OK check box is used to create multiple offset surfaces. 

• Select the Repeat object after OK check box and exit the Offset Surface Definition
dialog box.

• The Object Repetition dialog box is displayed, as shown in the figure.
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• Creating Swept surfaces

The Swept Surface Definition
dialog box

The sweep profile and guide 
curve

The resulting swept surface

• Choose the Sweep button from the Surfaces toolbar.

• The Swept Surface Definition dialog box is displayed, as shown in the figure.
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• Swept Surface with two Guide Curves

The sweep profile and guide curves The resulting swept surface
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• Swept Surface with Two Limits

The Swept Surface Definition
dialog box

The sweep profile and guide 
curves

The resulting swept surface

• To create a swept surface with two limits, you need to draw two limit curves.

• Next, invoke the Swept Surface Definition dialog box, as shown in the figure.
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• Swept Surface with Three Curves

The Swept Surface Definition
dialog box

The guide curves The resulting swept surface
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• Creating Fill Surfaces

The Fill Surface Definition
dialog box

The boundary curves The resulting fill surface

• Choose Fill button from the Surface toolbar.

• The Fill Surface Definition dialog box is displayed, as shown in the figure.
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• Creating Multisections Surfaces

The Multi-sections Surface 
Definition dialog box

Sections and guide curves The resulting multisection surface

Choose the Multi-sections surface button from the Surface toolbar; the Multi-
sections Surface Definition dialog box is displayed, as shown in the figure.
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• Creating Blended Surfaces

The Blend Definition
dialog box

The curves and support 
surfaces

The resulting blend surface

• To create a blended surface, draw some curves and create support surfaces. 

• Choose the Blend button from the Surfaces toolbar.

• The Blend Definition dialog box is displayed, as shown in the figure.



CATIA V5R16 for Designers Chapter 9

OPERATION ON THE SHAPE GEOMETRY
• Generally, the surface models are a combination of various surfaces. 

• You need to join, trim, split, or translate the surfaces to manage multiple surfaces. 

• CATIA V5 provides a number of such operation tools that can be used on the surfaces  
created using the tools discussed earlier in this chapter.

• Joining Surfaces

The Join Definition dialog box

When you invoke the Join tool; the Join Definition dialog box is displayed, as shown in 
the figure.
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• Spliting Surfaces

The split surface and the 
cutting surfaces

The resulting split surface

Surfaces to be joined Resulting joint surface
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• Trimming Surfaces

The Trim Definition
dialog box

The trimmed surfaces The trimmed surface with the Other
side of element buttons selected

When you invoke the Trim tool, the Trim Definition dialog box will be displayed, as shown 
in the figure.
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Tutorial 1
In this tutorial, you will create the model shown in Figure A. Its views and dimensions are 
shown in Figure B. (Expected time: 45 min)

Figure A The isometric 
view of the model

Figure B The views and 
dimensions of the model
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1. Start CATIA V5 and start a new file in the Wireframe and Surface Design workbench.

2. Draw the sketches for the multisections surface, as shown in Figure C, Figure D and
Figure E.

Figure C First section 
for the base surface

Figure D The second section 
for base surface

Figure E The line created between 
two points on the sections
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3. Create the multisections surface, as shown in Figure F and Figure G.

Figure F The sketch showing 
the position of closing points

Figure G The multisection lofted 
surface
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4. Draw the sketch to create the revolve surface, as shown in Figure H.

5. Create the revolved surface, as shown in Figure I.

Figure H The axis and 
profile to be revolved

Figure I The model after 
creating the revolved 
surface
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6. Draw the sketch to create the sweep profile, as shown in Figure J and Figure K.

Figure J The guide for 
the swept surface

Figure K The profile for the swept surface
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9. Save the file in \My Documents\CATIA\c09 folder and then close it.

7. Create the swept surface.

8. Split the swept surface with the revolved surface, as shown in Figure L.

Figure L The isometric view 
of the model after splitting 
the swept surface
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Tutorial 2
In this tutorial, you will create the model shown in Figure A. Its views and dimensions are 
shown in Figure B. (Expected time: 45 min)

Figure A The isometric view of the 
model

Figure B The views and dimensions 
of the model
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1. Start a new file in the Wireframe and Surface Design workbench.

2. Create a swept surface as the base feature, as shown in Figure C, Figure D and Figure E.

Figure C The guide curve

Figure D The sweep profile Figure E The resulting swept surface
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3. Create the second swept surface, as shown in Figure F, Figure G and Figure H.

Figure F The sketch of the guide curve 
for creating the second sweep feature

Figure G The sketch of the sweep profile 
for creating the second sweep feature

Figure H The model after creating 
the second sweep feature
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4. Create the symmetry of the second swept surface, as shown in Figure I.

Figure I The model after creating 
the symmetry feature
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5. Create the multisection surface, as shown in Figure J through Figure M.

Figure J The first section for 
creating the multisection 
surface

Figure K The second section for 
creating the multisection surface

Figure L The couplings 
and closing points

Figure M The model after creating 
the multisection surface
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6. Create the blended surface, as shown in Figure N and Figure O.

Figure N The sketch of 
the blended section

Figure O The model after creating the 
blend surface
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7. Create the fill surfaces, as shown in Figure P.

Figure P The final model

8. Save the file in \My Documents\CATIA\c09 folder and then close it.
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Exercise 1
In this exercise, you will create the surface model shown in Figure A. Its orthographic 
views are shown in Figure B. (Expected time: 30 min)

Figure A The isometric view 
of the model

Figure B The views of the model
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Exercise 2
In this exercise, you will create the surface model shown in Figure A. Its orthographic 
views are shown in Figure B. (Expected time: 45 min)

Figure A The isometric view 
of the model

Figure B The views of the model
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Learning Objectives:
• Create projection elements.

• Create intersections.

• Heal geometries.

• Restore surfaces.

• Extract elements.

• Create boundaries.

• Transform features.

• Create curves or surfaces by extrapolation.
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SURFACE OPERATIONS
CATIA V5 also provides you with various tools that are used to modify surfaces. These are 
known as surface operation tools and are used regularly while creating surface models.

• Creating Projection Curves

The Projection Definition
dialog box

Choose the Projection button from the Wireframe toolbar; the Projection Definition
dialog box is displayed, as shown in the figure.
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The curve and the 
support surface

The resulting projected 
element

• Creating Intersection Elements
When you invoke this tool, the Intersection Definition dialog box is displayed, as 
shown in the figure.

The Intersection Definition
dialog box
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• Intersection of Two Curves

Elements to be intersected and 
the resulting intersections

• Intersection of Two Surfaces

Surfaces to be selected Resulting intersection curve
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• Intersection of a Solid and a Surface
When a solid and a surface are intersected, the result could be a contour or a surface, 
depending on the option selected in the Surface-Part Intersection area in the 
Intersection Definition dialog box.

• Healing Geometries

The Join-Healing toolbar The Healing Definition
dialog box

Choose the Healing button from the Join-Healing toolbar to display the Healing
definition dialog box, as shown in the figure.
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The surface to be healed The resulting healed surface

• Disassembling Elements

The Disassemble dialog box

• To disassemble elements, choose the Disassemble button from the Join-Healing
tool bar. 

• The Disassemble dialog box is displayed, as shown in the figure.
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• Untrimming Surface or Curve

The Untrim dialog box The Warning box

To untrim a surface, choose the Untrim tool from the Join-Healing toolbar; the Untrim
dialog box is displayed, as shown in the figure.

The trimmed surface The untrimmed surface
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• Creating Boundary Curves

The Boundary Definition
dialog box

Boundary with a complete 
continuity

Boundary with a point 
continuity

Choose the Boundary button from the Operation toolbar to invoke the Boundary
Definition dialog box, as shown in the figure.
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Boundary with a tangent 
continuity

Boundary with no continuity

• Extracting Geometry

The Extract Definition
dialog box

• Choose the Extract button from the Extracts toolbar,    
which is invoked when you choose the down arrow  
on the right of the Boundary button in the Operations
toolbar.

• The Extract Definition dialog box is displayed, as  
shown in the figure.
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• Transformation Features

The Transformations toolbar

Transformation features are the features that are used to change the physical position of 
the geometry, such as translating, rotating, scaling, and so on.
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• Translating Elements

The Translate Definition
dialog box

Surface and directional 
reference

Resulting translated surface

To translate an element, choose the Translate button from the Transformations
toolbar; the Translate Definition dialog box is displayed, as shown in the figure.
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• Rotating Elements

The Rotate Definition
dialog box

Surface and the axis 
of rotation

Resulting rotated surface

When you choose the Rotate button from the Transformations toolbar, the Rotate
Definition dialog box will be displayed, as shown in the figure.
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• Creating Symmetry Elements

The Symmetry Definition
dialog box

When you invoke the Symmetry tool, the Symmetry Definition dialog box is 
displayed, as shown in the figure.

Surface and the reference 
element

Resulting mirrored surface
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• Scaling Elements

The Scaling Definition
dialog box

When you invoke this tool, the Scaling Definition dialog box is displayed, as shown 
in the figure.

Surface and the reference 
element

Resulting scaled surface
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• Nonuniform Scaling of Elements

The Affinity Definition
dialog box

Surface to be selected Resulting nonuniform scaling

When you invoke this tool, the Affinity Definition dialog box is displayed, as shown 
in the figure.
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• Transforming an Element From Axis to Axis

The Axis To Axis Definition
dialog box

Surface and axes to be 
selected

Resulting transformed surface

When you invoke this tool, the Axis To Axis Definition dialog box is displayed, as 
shown in the figure.
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• Extrapolating Surfaces and Curves

The Extrapolate Definition
dialog box

Boundary and surface to 
be selected

Resulting extrapolated surface

When you invoke the Extrapolate tool, the Extrapolate Definition dialog box is 
displayed, as shown in the figure.
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Boundary and curve to 
be selected

Resulting extrapolated curve
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• Splitting a Solid Body With a Surface

The Surface-Based Features 
(Extended) toolbar

The Split Definition dialog box

Choose the Split button from the Surface-Based Features (Extended) toolbar; the 
Split Definition dialog box is displayed, as shown in the figure.

Body to be split and the 
splitting surface

Resulting solid body after 
hiding the splitting surface
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SOLIDIFYING SURFACE MODELS
• Adding Thickness to a Surface

The ThickSurface Definition
dialog box

Surface to be thickened Resulting solid model

• To add thickness to a surface you first need to switch to the Part workbench and
then choose the Thick Surface button from the Surface- Based Features
(Extended) toolbar.

• The ThickSurface Definition dialog box is displayed, as shown in the figure.
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• Creating a Solid Body From a Closed Surface Body

The CloseSurface Definition
dialog box

Surface with open ends Resulting closed body

When you invoke the Close Surface tool, the CloseSurface Definition dialog box 
is displayed, as shown in the figure.
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• Sewing a Surface With a Solid Body

The Sew Surface Definition
dialog box

Solid body Surface created on the 
solid body

Choose the Sew Surface button from the Surface-Based Features (Expanded)
toolbar; the Sew Surface Definition dialog box is displayed, as shown in the figure.
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Surface to be sewed and 
face to be removed

Resulting solid body

Surface to be sewed and 
face to be removed

Resulting solid body
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Tutorial 1
In this tutorial, you will create the model of the back cover of a toy monitor shown in 
Figure A. This model will be created using the tools in the Wireframe and Surface
Design workbench and the Part Design workbench. After creating the surface 
model,you need to convert it into a solid body. Its views and dimensions are shown 
in Figure B. (Expected time: 1 hr)

Figure A Back cover 
of the toy monitor

Figure B Views and dimensions 
for Tutorial 1
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1. Start a new file in the Wireframe and Surface Design workbench and create the base 
surface of the model by extruding the sketch drawn on the zx plane, as shown in Figure
C and Figure D.

Figure C Sketch of the 
base feature

Figure D Resulting base 
surface
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2. Create the other surfaces that are required for the basic structure of the model, as shown 
in Figure E through Figure N.

Figure E Reference sketch Figure F Point and curve to 
be selected
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Figure G Sketch to be drawn 
on the new plane

Figure H Point and curve 
to be selected

Figure I Sketch to be drawn 
on the new plane

Figure J Resulting lofted 
surface
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Figure K Sketch to be drawn Figure L Resulting
extruded surface

Figure M Surface and reference 
to be selected

Figure N Resulting 
mirrored surface
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3. Trim the unwanted surfaces, as shown in Figure O.

4. Invoke the Part workbench and convert the surface model into a solid model, as shown 
in Figure P.

Figure O The model after 
trimming the surfaces

Figure P The model after 
solidifying the surfaces
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5. Fillet the edges and shell the model, as shown in Figure Q.

Figure Q Final model for Tutorial 1

6. Save the file in \My Documents\CATIA\c10 folder and then close it.
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Tutorial 2
In this tutorial, you will create the model of the Hair Dryer Cover shown in Figure A. It 
will be created using the tools in the Wireframe and Surface Design workbench and 
the Part Design workbench. The views and dimensions are shown in Figure B.

(Expected time: 1 hr)

Figure A Model of the Hair Dryer Cover Figure B Views and dimensions 
for Tutorial 2
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1. Start a new file in the Wireframe and Surface Design workbench and create the base 
surface, which forms the body of the Hair Dryer Cover, using Multisections surface
tool, as shown in Figure C and Figure D.

Figure C Sketches of sections 
and guide curves

Figure D Resulting base surface



CATIA V5R16 for Designers Chapter 10

2. Create a swept surface that forms the handle of the cover, as shown in Figure E, Figure F,
Figure G and Figure H.

Figure E Sketch of the first 
guide curve

Figure F Sketch of the 
second guide curve
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Figure G Profile, guide curves, and 
anchor points to be selected 

Figure H Resulting swept surface
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3. Trim the surfaces and create a flat boundary surface to close the surface body, as shown 
in Figure I, Figure J, Figure K and Figure L.

Figure I Intersecting surfaces Figure J Resulting trimmed surface
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Figure K Curves to be selected Figure L Resulting filled surface

Figure M The model after creating 
all the flat boundary surfaces
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4. Join the surfaces together.

5. Invoke the Part Design workbench and solidify the surface body using the Close Surface
tool, as shown in Figure N.

Figure N Resulting solid body
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6. Create the remaining features of the model using the Edge Fillet and Shell tools, as shown 
in Figure O.

Figure O Final model of the Hair 
Dryer Cover

7. Save the file in \My Documents\CATIA\c10 folder and then close it.
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Exercise 1
Create the model of the Cover shown in Figure A. Its views and dimension are shown 
in Figure B. (Expected time: 30 min)

Figure A Model of the cover Figure B Views and dimensions of 
the model



CATIA V5R16 for Designers Chapter 11

Learning Objectives:
• Insert components into an assembly file.

• Create bottom-up assemblies.

• Insert components into a product file.

• Move and rotate components inside an assembly.

• Add constraints to individual components.

• Create top-down assemblies.

• Edit assembly designs.

• Create the exploded state of an assemblies.
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ASSEMBLY MODELING
• The primary method to start a new product file is by selecting File > New from the menu

bar to open the New dialog box. 

• From this dialog box, select Product, as shown in Figure A.

The Product option selected 
from the New dialog box

Screen display after starting a new file in the 
Assembly Design workbench



CATIA V5R16 for Designers Chapter 11

• Types of Assembly Design Approach

• Bottom-up Assembly

• Top-down Assembly
The bottom-up assembly is the most preferred approach for creating assembly models.

In the top-down assembly design approach, components are created inside the Assembly
Design workbench.

In CATIA V5 you can create assembly models by adopting two types of approaches.
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CREATING BOTTOM-UP ASSEMBLIES
• Inserting Components in a Product file

The Part number conflicts dialog box The specification tree showing 
four components

When you insert additional components, the Part number conflicts dialog box is 
displayed, as shown in the figure.
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The Part Number
dialog box

The specification tree showing 
four components with unique 
part numbers

If you choose the Rename button from the Part number conflicts dialog box, the Part
Number dialog box is displayed, as shown in the figure.

• Moving Individual Components
CATIA allows you to move and rotate the individual unconstrained components inside the 
product file without affecting the position and location of the other components.
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• Moving and Rotating by Using the Manipulation Tool

The Manipulation Parameter
dialog box

To translate or rotate any component, choose the Manipulation button from the Move
toolbar; the Manipulation Parameter dialog box is displayed, as shown in the figure.
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• Moving Components by Using the Snap Tool

Geometric elements 
selected to be 
snapped

Position of components 
after snapping

Position of components after 
the snapping direction is 
reversed
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• Moving Components by Using the Smart Move Tool

The expanded Smart 
Move dialog box

• To invoke this tool, choose the down arrow besides the Snap button to invoke the
Snap toolbar.

• Choose the Smart Move button to invoke the Smart Move dialog box.

• Choose the More button to expand it, as shown in the figure.
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Surfaces to be selected Resulting constraint applied

The partial view of the Smart 
Move dialog box with viewer
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• Manipulating Components using the Compass

• Applying Constraints
• Fix Component Constraint
• Coincidence Constraint

Central axis of the first component 
to be selected

Central axis of the second 
component to be selected

The orientation of the components can also be manipulated using the compass on the top 
right corner of the geometry area.
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Coincidence constraint applied 
between two components

Position of the components 
after updating
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• Contact Constraint

Planar faces to be selected Position of components, after a 
constraint is applied and updated
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• Offset Constraint

The Constraint Properties dialog box

• After invoking the Offset Constraint tool, you are prompted to select the first  
geometric element for the Offset constraint.

• Select a planar face, circular face, plane, axis, or a point from the geometry area. 

• Select a planar face of another component; the Constraint Properties dialog box
is displayed, as shown in the figure.
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Faces to be selected Arrows in the same direction

Components after updating
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• Angle Constraint

The Constraint Properties dialog box for the 
Angle constraint

• To invoke this tool, choose the Angle Constraint button from the constraint toolbar.

• Now, select the two planar faces from the two different components that you need to   
place at some angle from each other. 

• Once the selection is complete, the Constraint Properties dialog box is displayed,
as shown in the figure.
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Faces to be selected The orientation of the faces 
after applying the Angle
constraint and updating
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• Fix Together

The Fix Together dialog box

To invoke this tool, choose the Fix Together button from the Constraints toolbar;
the Fix Together dialog box is displayed.
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• Quick Constraint

• Reuse Pattern

The Pin and the Plate having
patterned holes

The Pin assembled to one of the 
instances of the patterned hole

To apply constraints, choose the Quick Constraint button from the Constraints
toolbar.
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The Instantiation on
a pattern dialog box

• After selecting the Coincidence constraint, choose the Reuse Pattern button from the  
Constraints toolbar. 

• The preview of Pins assembled with all instances of hole is displayed in the geometry
area.

• The Instantiation on a pattern dialog box is displayed, as shown in the the figure.
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The assembly after the 
selected component is 
patterned

The Specification tree after 
creating the component 
pattern
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• Inserting Existing Components With Positioning

CREATING TOP-DOWN ASSEMBLIES
• Creating Base Part in Top-Down Assembly

The fully expanded specification tree 
after inserting a part in the product file

The Existing Component With Positioning tool is used to insert, position, and apply 
constraints to a component in a single operation and is an enhanced form of the Insert
Existing Component tool.
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• Creating Subsequent Components in the Top-down Assembly

Two different parts created in 
a product file and the cylinder 
extruded up to surface

Up to surface relation maintained even 
after moving the base downward 
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• Creating Subassemblies in Top-down Assembly

• Product Subassemblies
• Component Subassemblies

The specification tree having 
a product and a component 
within an assembly file.

• While creating complicated assemblies, you may need to have subassemblies inside an
assembly.

• In CATIA V5, there are two types subassemblies that can be created in the Assembly
Design workbench: Product and Component.
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EDITING ASSEMBLIES
• Deleting Components

The Delete dialog box

While working in the Assembly Design workbench, you may need to delete some of the 
constituent parts and subassemblies.
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• Replacing Components
In CATIA V5 you can replace an existing component with another component inside 
an assembly.

The original component The replaced component
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• Editing Components Inside an Assembly

• Editing Subassemblies Inside an Assembly
• Editing the Assembly Constraints

• Editing the Constraint Definition

The Constraint Definition dialog box

You can also edit the features and modify the sketches of the parts of assembly within the 
Assembly Design workbench.
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The associated and replacing surface 
for the Offset constraint

The components after editing the 
offset constraint and updating it
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• Replacing a Constraint

Contact constraint to be replaced 
by the Offset constraint

The components after applying 
the Offset constraint
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• Hiding a Component

• Deactivating a Component

• Simplifying the Assembly
While working on large assemblies consisting of a large number of parts and subassemblies, 
it is recommended to hide some of the parts to improve the visibility of other parts and to 
suppress the parts that are not required at that particular stage of design cycle.

The Hide/Show tool is used turn off the display of the selected component of the 
assembly.

Deactivating the component removes it temporarily from the assembly.
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• Interference Detection

The Check Clash dialog box The Preview window

The interference is detected using the Clash tool, which is invoked by choosing the 
Clash button from the Space Analysis toolbar. The Check Clash dialog box is 
displayed, as shown in the figure.
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• Sectioning an Assembly

The Sectioning Definition
dialog box

The 2D section view of 
the complete assembly

The sectioning plane

To section an assembly model, choose the Sectioning button from the Space
Analysis toolbar; the Sectioning Definition dialog box is displayed, as shown 
in the figure.
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• Exploding an Assembly

The Explode dialog box

The Belt Tightener in 
the assembled state

Overlapping components in 3D 
explosion of the assembly

To explode an assembly, choose the Explode button from the Move toolbar; the 
Explode dialog box will be displayed, as shown in the figure.
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Front view of the exploded Belt 
Tightener assembly exploded 
using the 2D option

Top view of the exploded Belt 
tightener assembly

Figure showing the exploded assembly 
with Constrained selected as the type
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Tutorial 1
In this tutorial you will create all the components of the Blower assembly and then assemble 
them together. The Blower assembly is shown in Figure A. After creating it, you will 
generate the exploded view. The exploded view of the Blower assembly is shown in Figure 
B. The dimensions of all components are given in Figure C, Figure D, Figure E, Figure F,
Figure G and Figure H. (Expected time: 2.5 
hrs)

Figure A The Blower Assembly Figure B Exploded view of the 
Blower assembly
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Figure C Views and dimensions of 
the Upper Housing

Figure D Views and dimensions of 
the Lower Housing
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Figure E Views and dimensions 
of the Blower

Figure F Views and dimensions of 
the Motor
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Figure G Views and dimensions 
of the Cover

Figure H Views and dimensions of 
the Motor Shaft
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1. Create all components of the assembly as separate part files in the Part Design workbench.

2. Start a new file in the Assembly Design workbench.

3. Insert the Lower Housing into the assembly as the base component, set its orientation, 
and apply the Fix constraint to it at its default location, as shown in Figure I, Figure J
and Figure K.

Figure I First and second 
elements to be selected
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Figure J The Lower Housing 
after modifying its orientation

Figure K Lower Housing after it 
is fixed at its default location
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4. Insert the Upper Housing into the assembly and place it over the lower housing by applying 
proper constraints, as shown in Figure L, Figure M and Figure N.

Figure L The surfaces to be 
selected to apply Contact
constraint

Figure M Surfaces on which 
you need to click to select 
the central axes

Figure N The surfaces to be 
selected for applying Offset
constraint
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5. Hide the Upper Housing. Insert and place the blower inside the lower Housing.

6. Now, insert and constrain the Motor, the Motor Shaft, and the Cover refer to Figure O,
Figure P, Figure Q, Figure R, Figure S, Figure T and Figure U.

Figure O Faces to be clicked 
to select the central axes

Figure P Faces to be selected 
for applying Offset constraint
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Figure Q Motor Shaft 
inserted at its default 
location

Figure R Faces to be 
selected for Offset
constraint

Figure S Position of the Motor 
Shaft with respect to the Blower 
shown from back side
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Figure T Elements to be selected 
for applying various constraints

Figure U Various faces to be 
selected for applying the 
constraints
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7. Turn on the display of the Upper Housing, as shown in Figure V.

Figure V The final Blower assembly
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8. Create the exploded state of the assembly, as shown in Figure W.

Figure W The exploded view of Blower assembly

9. Save the file in \My Documents\CATIA\c11 folder and then close it.
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Tutorial 2
In this tutorial you will create some components of a Press Tool Base assembly using the 
top-down assembly approach. The Press Tool Base assembly is shown in Figure A. The 
exploded state of this assembly is shown in the Figure B. The dimensions of all 
components are shown in Figures C and Figure D. (Expected time: 45 min)

Figure A The Press Tool 
Base assembly

Figure B The exploded state of 
the Press Tool Base assembly
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Figure C Views and dimensions 
of the Top Plate, Guide Pillar, 
and Guide Bush

Figure D Views and dimensions 
of the Bottom Plate
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Figure E Drawing views of the 
Press Tool Base assembly
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1. Start a new product file.

2. Create a new part inside the assembly. Modify its name and create features of the base 
component, as shown in Figure F. In this assembly the Bottom Plate will be the base 
component.

Figure F The final model of the 
Bottom Plate
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3. Create the Guide Bush and Guide Pillar as subsequent components inside the product file, 
as shown in Figure G, Figure H and Figure I.

Figure G The final Guide Pillar

Figure H Sketch of Pad feature 
for creating Guide Bush

Figure I Final Guide Bush
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4. Guide Pillar and Guide Bush are to be duplicated using the Reuse Pattern tool, as shown 
in Figure K.

Figure K The assembly after placing 
the second set of Guide Pillar and 
Guide Bush
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5. Create the Top Plate, as shown in Figure L.

Figure L Sketch of the Pad feature 
for creating Top Plate

Figure M The final Press 
Tool Base assembly

6. Save the file in \My Documents\CATIA\c11 folder and then close it.
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Exercise 1
Create the assembly of the Radial Engine shown in Figure A. The assembly in the 
exploded state is shown in Figure B. Note that this exploded view is provided only for 
your understanding and has not been generated using CATIA V5. The dimensions of 
various parts of this assembly model are given in Figure C and Figure D.

(Expected time: 3 hr 30 min)

Figure A The Radial Engine assembly Figure B Exploded view of the 
Radial Engine assembly
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Figure C Positioning of 
the Articulated Rods

Figure D Views and dimensions 
of the Master Rod
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Learning Objectives:
• Start new files in the Drafting workbench.

• Generate views using the View Creation
Wizard.

• Generate front views.

• Generate advanced front views.

• Generate projected views.

• Generate auxiliary views.

• Generate isometric views.

• Generate section views.

• Generate aligned section views.

• Generate section cuts.

• Generate aligned section cuts.

• Generate detail views.

• Generate detail view profiles.

• Generate clipping views.

• Generate clipping view profiles.

• Generate broken views.

• Generate breakout views.

• Edit and modify drawing views.

• Modify hatch patterns of the
section views.
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THE DRAFTING WORKBENCH
• After creating parts and assembling them, you need to generate their drawing views.

• A 2D drawing is the life line of all the manufacturing systems because on the shop floor or
tool room, the machinist mostly needs the 2D drawings for manufacturing.

• CATIA V5 provides you with the Drafting workbench, which is a specialized environment
for generating 2D drawing views.

• This workbench provides all tools required to generate drawing views, modify them, and
apply dimensions and annotations to them.

• Starting a New File in the Drafting Workbench
To generate drawings views, you first need to start a new file in the Drafting workbench.
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• Starting a New File in the Drafting Workbench Using the New Tool

The New Drawing dialog box

• To start a new file in the Drafting workbench using the New tool, choose the New
button from the Standard toolbar.

• The New dialog box will be displayed. Select Drawing and choose the OK button.

• The New Drawing dialog box is displayed, as shown in the figure.
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• Standard
• Sheet Style

The options available in the New Drawing dialog box are:

The initial screen after starting a new file in the 
Drafting workbench
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• Starting a New File in the Drafting Workbench Using the Start Menu
• To start a new file in the Drawing workbench using this option, choose Start > Mechanical  

Design > Drafting from the menu bar. 

• The New Drawing Creation dialog box is displayed, as shown in the figure.

The New Drawing Creation dialog box
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• Empty Sheet
• All Views
• Front, Bottom and Right
• Front, Top and Left

TYPE OF VIEWS
• Front View
• Projected View
• Section View
• Aligned Section View
• Auxiliary View
• Detail View
• Clipping View
• Broken View
• Breakout View

The options available in the New Drawing Creation dialog box are:
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GENERATING THE DRAWING VIEWS

• Automatically Generating the Views

The Wizard toolbar

In CATIA V5, there are two methods of generating the views after you start an empty file 
in the Drafting workbench, using Wizards and generating the drawing views is generating 
each view one by one.
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• Generating the Views Using the View Creation Wizard

The View Wizard dialog box Preview of the front view on the lower 
right corner of the geometry area

When you invoke the View Creation Wizard tool, the View Wizard dialog box is 
displayed, as shown in the figure.
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Controls provided on the blue knob Views generated using the View 
Creation Wizard dialog box
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• Generating the Front, Top, and Left Views

• Generating the Front, Bottom, and Right Views

• Generating All the Views

• Generating individual Drawing Views
• Generating the Front View

The Projection toolbar The front view generated using the 
Front View tool
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• Generating the Advanced Front View

The View Parameters dialog box The front view generated using 
the Advanced Front View tool

To generate a front view using this tool, choose the Advanced Front View button 
from the Projections toolbar; the View Parameters dialog box is displayed, as 
shown in the figure.
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• Generating Projected Views

Top view generated from the front 
view using the Projection View tool
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• Generating Auxiliary Views

Reference to be selected to 
generate the auxiliary view

Auxiliary view placed 
above the parent view

Auxiliary view placed 
below the parent view
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• Generating Isometric Views

Isometric view generated 
using the Isometric View
tool

• Generating Section Views

The Sections toolbar
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Full section view Offset section view

Half section view
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• Creating the Partial Section View

The partial section view
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• Generating the Aligned Section Views

Aligned section view

Aligned section view with 
inclined line drawn first

Aligned section view with 
vertical line drawn first
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• Generating the Offset Section Cut

Offset section cut
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• Generating the Aligned Section Cut

Aligned section cut
• Generating Detail Views

The Details toolbar Detail view
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• Generating the Detail View Profiles

Detail view profile

• Generating Clipping Views

The Clippings toolbar Clipping view
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• Generating the Clipping View Profiles

Clipping view profile

• Generating the Broken View

The Break view toolbar
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The front view that needs to be broken Resulting broken view

A broken isometric view Zigzag broken lines
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• Generating the Breakout View

Zigzag broken lines The 3D Viewer window

Breakout view
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• Generating the Exploded View

The Enhanced Scene
dialog box

Drawing view of the 
exploded assembly

Choose the Enhanced Scene button from the DMU Review Creation toolbar to display 
the Enhanced Scene dialog box, as shown in the figure.
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WORKING WITH INTERACTIVE DRAFTING IN CATIA V5
• You can also sketch the 2D drawing views in the Drafting workbench of CATIA V5.

• In technical terms, sketching 2D drawings is known as interactive drafting.

EDITING AND MODIFYING THE DRAWING VIEWS
• In CATIA V5, you can perform editing operations and modifications on the drawing views.

• The various options under the Editing and Modifying Drawing Views option are:

• Changing the Scale of Drawing Views
• Modifying the Project Plane of the Parent View
• Deleting Drawing Views
• Rotating Drawing Views
• Hiding Drawing Views
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MODIFYING THE HATCH PATTERN OF SECTION VIEWS
When you generate a section view of an assembly or a component, a hatch pattern based on 
the material assigned to the components in the part document is applied to the component or 
components.

The Properties dialog box to 
modify the hatch pattern
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Tutorial 1
In this tutorial, you will generate the drawing views of the model of Motor Cover created in 
Tutorial 2 of Chapter 7. You will generate the front view, top view, aligned section views 
from the top view, detail view, and the isometric view. You will use the A4 standard sheet 
size and the third angle projection. The drawing sheet after generating all the views is 
shown in Figure A. (Expected time: 30 min)

Figure A Drawing views to be generated
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1. Copy the part document of Tutorial 2 from Chapter 7 to the folder of the current chapter.

2. Start a new file in the Drafting workbench with the standard A4 sheet size.

3. Set the projection standard to third angle.

4. Generate the front view, which will be used as the main view, as shown in Figure B.

Figure B The drawing sheet after 
generating the front view
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5. Generate the top view using the Projection View tool, as shown in Figure C.

Figure C The drawing sheet after 
generating the top view
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6. Generate the aligned section view from the top view after activating it, as shown in Figure D
and Figure E.

Figure D Sketch for 
the section view

Figure E The drawing sheet after generating 
the aligned section view
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7. Generate the detail view, as shown in Figure F and Figure G.

Figure F Sketch for 
the detail view

Figure G The drawing sheet after 
generating the detail view
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8. Generate the isometric view, as shown in Figure H.

Figure H The final drawing sheet with all views

9. Save the file in \My Documents\CATIA\c12 folder and then close it.
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Tutorial 2
In this tutorial, you will create the Bench Vice assembly and then generate the front, 
top, right, and isometric views of the same, as shown in Figure A. Figure B, Figure
C, Figure D, and Figure E shows the views and dimensions of the components of 
the Bench Vice assembly. (Expected time: 2 hrs)

Figure A Drawing view of the Bench 
Vice assembly

Figure B Views and dimensions of 
the Vice Jaw
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Figure C Views and dimensions 
of the Vice Jaw

Figure D Views and dimensions of various 
components of the Bench Vice
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Figure E Views and dimensions of various 
components of the Bench Vice
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1. Create all components of the Bench Vice assembly and assemble them.

2. Start a new file in the Drafting workbench using the A2 size sheet.

3. Set the standard of the projection to third angle.

4. Generate the front view, as shown in Figure F.

Figure F The Drawing sheet after 
generating the front view
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5. Generate the top view, as shown in Figure G.

Figure G The drawing sheet after 
generating the top view
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6. Generate the right view, as shown in Figure H.

Figure H The drawing sheet after 
generating the right view
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7. Generate the isometric view, as shown in Figure I.

Figure I Final drawing sheet after generating 
all views

8. Save the file in \My Documents\CATIA\c12 folder and then close it.
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Exercise 1
Create the components of the V-Block and generate the front, top, right, detail, and isometric 
views, as shown in Figure A. The views and dimensions of the components of the V-Block 
are shown in Figure B and Figure C. (Expected time: 1 hr)

Figure A Drawing views of the 
V-Block assembly

Figure B Views and dimensions 
of the V-Block body
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Figure C Views and dimensions of the 
U-Clamp and Fastener
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Learning Objectives:
• Insert additional sheets in the current drawing file.

• Insert frames and title blocks.

• Add annotations to the drawing views.

• Edit the annotations.

• Generate the Bill of Material (BOM).

• Generate balloons.
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INSERTING SHEETS IN THE CURRENT FILE
• You can insert additional sheets to the current drafting file.

• This is good practice when you need to generate the drawing views of all the components  
of an assembly and also its other views such as the isometric view or a view with Bill of  
Material (BOM), and balloons in a single drawing file.

Partial view of the drawing with a 
new sheet added to the current file
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INSERTING THE FRAME AND TITLE BLOCK
• Automatic Insertion of the Frame and Title Block

The Insert Frame and Title Block dialog box

• Choose the Frame Creation button from the Drawing toolbar.

• The Insert Frame and Title Block dialog box is displayed, as shown in the figure.
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• Style of Titleblock
• Action

• Creation

• Deletion

• Resizing

• Update

• Checked By

• AddRevisionBlock

The drawing sheet after adding the frame and title 
block to the drawing sheet
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The Controller’s name dialog box

• Creating the Frame and Title Block Manually

The drawing sheet after drawing 
the frame and title block
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The Text Editor dialog box

• Adding Text in the Title Block
• Select a point on the drawing sheet to place the text. 

• The Text Editor dialog box is displayed, as shown in the figure.
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• Inserting the Logo

The drawing sheet after completing the frame 
and title block
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ADDING ANNOTATIONS TO THE DRAWING VIEWS
After generating the drawing views, you need to generate the dimensions in the drawing 
views and add the other annotations, such as notes, surface finish symbols, geometric 
tolerance, and so on.

• Generating the Dimensions
• Generating all Dimensions Together

The Dimension Generation 
Filter dialog box

• Exit the Options dialog box and then choose the Generate Dimensions button
from the Dimension Generation toolbar, after invoking it from the Generation
toolbar.

• The Dimension Generation Filters dialog box is displayed, as shown in the figure.
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The options available in the Dimension Generation Filter dialog box are:

• Type of constraint Area
• Options Area
• Retrieve excluded constraints
• Add All Parts

• Generating Dimensions Step by Step

The Step by Step Generation dialog box

• If the Dimension Generation Filter dialog box is displayed, set the option in this  
dialog box and choose the OK button to exit it. 

• The Step By Step Generation dialog box is displayed, as shown in the figure.
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• Creating Reference Dimensions

The Tools Palette toolbar

• Creating the Chamfer Dimensions

The Tools Palette toolbar
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Selection sequence Resulting chamfer dimension

Selection sequence Resulting chamfer dimension
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• Adding Datum Features

The Datum Feature 
Creation dialog box

• Adding Geometric Tolerance to the Drawing Views

The Geometrical Tolerance dialog box

Move the cursor to the desired location and click a point on the
drawing sheet to place the datum feature; the Datum Feature
Creation dialog box is displayed, as shown in the figure.

Move the cursor to an appropriate location and click on the drawing sheet to place 
the tolerance on that location; the Geometrical Tolerance dialog box is displayed, 
as shown in the figure.
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The options available in the Geometrical Tolerance dialog box are:

• Tolerance
• Reference

The drawing view after adding 
datum feature and tolerance
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• Adding Surface Finish Symbols

Figure A The Symbols toolbar Figure B The Roughness Symbol
dialog box

• Choose the Roughness Symbol button from the Symbols toolbar, after invoking it  
from the Annotations toolbar.

• The Symbols toolbar is shown in Figure A.

• Click on the surface from where you need to place the roughness symbol. 

• Its preview is displayed attached to the selected point and the Roughness Symbol
dialog box is displayed, as shown in Figure B.
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• Adding Welding Symbols

The Welding creation dialog box The drawing view after adding 
the welding symbol

Move the cursor and click on an appropriate location on the drawing sheet to 
place it; the Welding creation dialog box is displayed, as shown in the figure.
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• Applying Weld

The Welding Editor dialog box Drawing view after adding the welding symbol

To apply a weld, choose the Weld button from the Symbols toolbar.

EDITING ANNOTATIONS
You can edit the annotations added to the drawing views by double-clicking on them to 
display their respective dialog boxes.
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The Generate Numbering
dialog box

The drawing sheet after generating 
the BOM

GENERATING THE BILL OF MATERIAL (BOM)
• To number the components, switch to the assembly file from which the drawing views

are generated. 

• Choose the Generate Numbering button from the Product Structure Tools toolbar.

• Now, select Product1 from the Specification Tree; the Generate Numbering dialog
box is displayed, as shown in the figure.
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GENERATING BALLOONS

The drawing sheet after generating balloons

The Generate Balloons tool is used to generate balloons that are attached to the 
drawing view of an assembly.
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Tutorial 1
In this tutorial, you will create the model shown in Figure A. After creating it you need to 
generate the front, top, and the isometric views in the Drafting workbench. You also 
need to generate the dimensions in the drawing views. The views and dimensions are 
shown in Figure B. (Expected time: 45 min)

Figure A Model for Tutorial 1 Figure B Views and dimensions 
for Tutorial 1
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1. Create the model in the Part workbench and save the file in the c13 folder.

2. Start a new file in the Drafting workbench with the standard sheet of A2 size.

3. Set the projection standard to third angle.

4. Create a standard title block and frame in the background editing mode, as shown in 
Figure C.

Figure C The drawing sheet after 
creating the title block and frame
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5. Generate the front view, as shown in Figure D.

Figure D The drawing sheet after 
generating the front view

6. Generate the top view, as shown in Figure E.

Figure E The drawing sheet 
after generating the top view
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6. Generate the isometric view, as shown in Figure F and Figure G.

Figure F Drawing sheet after generating 
the isometric view 

Figure G Drawing sheet after modifying 
the display
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7. Generate the dimensions, as shown in Figure H.

Figure H The drawing sheet 
after generating dimensions
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8. Arrange the dimensions and delete the unwanted dimensions,as shown in Figure I and
Figure J.

Figure J Final drawing sheet

9. Save the file in \My Documents\CATIA\c13 folder and then close it.

Figure I Drawing sheet after 
arranging dimensions
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Tutorial 2
In this tutorial, you will generate the front, top, right, and isometric views of the V-Block 
assembly created in the Exercise 1 of Chapter 12. You also need to generate the BOM 
and balloons.                                                   (Expected time: 30 min)

1. Copy the V-Block folder to the c13 folder.

2. Open the assembly file.

3. Start a new file in the Drafting workbench.

4. Generate the front view.

5. Generate the top view.

6. Generate the right view.

7. Generate the isometric view.
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Figure A The drawing sheet after generating 
the front, top, right, and isometric views

8. The drawing sheet after generating all the drawing views is shown in Figure A.
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9. Generate the BOM.

10. Generate the balloons.

11. The final drawing sheet after generating the BOM and balloons is shown in Figure B.

Figure B The final drawing sheet

12. Save the file in \My Documents\CATIA\c13 folder and then close it.
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Exercise 1
Generate the front, top, right, and isometric views of the Blower assembly created in 
Tutorial 1 of Chapter 11. The drawing view will be generated with the scale factor of 
1:5. After generating the drawing views, you need to generate the BOM and balloons, 
as shown in Figure A. (Expected time: 30 min)

Figure A Drawing views for Exercise 1


